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Lukijalle 
 
 
Tässä koulutusraportissa esitellään menetelmä (StrateGIS), jolla voidaan mallintaa rakennetun ympäristön 
hyvinvointitekijöitä kartalle kuntien tai kaupunkiseutujen hyvinvoinnin suunnittelun ja päätöksenteon tueksi. 
Materiaali on tuotettu osana Hyvinvointiympäristön tietopohjan mallintaminen ja hyvinvointijohtamisen 
kehittämisen verkostohanketta (HYMY), joka on saanut avustusta STM:n terveyden edistämisen määrärahasta. 
 
Menetelmän soveltamista testattiin yhdessä Tampereen seudun kuntayhtymän, Tampereen, Jyväskylän, Lahden, 
Kuopion, Kangasalan, Nokian, Oriveden ja Ylöjärven kaupungin sekä Lempäälän, Pirkkalan ja Vesilahden kunnan 
toimijoiden kanssa. Menetelmän testaus Suomen ympäristökeskuksen (SYKE) johdolla suoritettiin aikavälillä 
lokakuu 2019 – helmikuu 2020. Testauksen pohjalta on koostettu tämä koulutusmateriaali, joka tähtää 
menetelmän itsenäiseen toistamiseen organisaatioissa. Koulutusmateriaali sisältää tämän koulutusraportin, 
taustoitusesityksen, paikkatietotyökalun esimerkkiaineistoineen, esimerkkiarvopuut kaikilta pilottialueilta sekä 
pisteytykseen tarvittavan Excel-laskurin. Lisäksi pisteytysten yhdistämisestä paikkatietoaineistoihin on käytössä 
tallenne webinaarista 10.12.2019, jossa esitellään luvussa 2.5.3 kuvatun paikkatietotyökalun toiminta 
esimerkkiaineiston avulla. 
 
 
 
 
 
 
 



1 StrateGIS-menetelmän tausta 
 
 
Rakennettuun ympäristöön liittyvät ilmiöt ja vaikutukset ovat monimutkaisia, ja niiden jäsentämiseen 
tarvitaan suuri määrä muuttujia. Monitavoitearvioinnin menetelmät vastaavat päätöksenteon haasteisiin 
huomioimalla useiden eri tekijöiden vaikutuksia toisiinsa sekä asetettuihin tavoitteisiin (esim. Marttunen 
ym. 2008). Kun menetelmään yhdistetään myös alueellinen ulottuvuus, päätöksenteon tueksi syntyy 
paikkatietoa. Tällöin puhutaan spatiaalisesta monitavoitearvioinnista. Spatiaalisen monitavoitearvioinnin 
menetelmiä on Suomessa aiemmin testattu mm. viherrakenteen ja täydennysrakentamisen 
yhteensovittamiseen Järvenpään kaupungin toimijoiden kanssa (Tiitu ym. 2016; Tiitu ym. 2018) sekä 
kierrätyspuiston sijainnin optimoimiseen Päijät-Hämeen maakunnassa (Kopperoinen ym. 2019). 
 
Osa ihmisten hyvinvointiin vaikuttavista tekijöistä voi olla tutkimusten perusteella tärkeämpiä kuin toiset, 
mutta useimmiten tekijöiden keskinäinen merkittävyys sisältää myös arvovalintoja. Arvovalintoja 
monitavoitearvioinnissa edustavat painokertoimet, joilla eri tekijöiden tärkeyseroja suhteessa asetettuihin 
tavoitteisiin kuvataan. Spatiaalinen monitavoitearviointi ei ole objektiivinen menetelmä, vaan se sisältää 
subjektiivisia painokertoimia, jotka työstetään yhdessä osallisten kanssa. Osallistavuus ei kuitenkaan koske 
pelkästään eri tekijöiden pisteytystä, vaan koko tutkimusongelma sekä tavoitteet jäsennellään yhdessä 
osallisten kanssa.  
 
HYMY-hankkeessa on kehitetty strategista päivitettävää työkalua (StrateGIS), joka pohjautuu spatiaaliseen 
monitavoitearviointiin ja hyödyntää avoimia paikkatieto-ohjelmia (R, QGIS). Johtavana tavoitteena on ollut 
kuntien alueellisen hyvinvoinnin suunnittelun tukeminen ja hyvinvoinnin alueellisten erojen saaminen 
kartalle suunnittelun ja päätöksenteon tueksi. Menetelmässä ei ole ollut tavoitteena ratkoa mitään 
yksittäistä suunnitteluongelmaa (vrt. Järvenpään ja Päijät-Hämeen tutkimukset), vaan hahmottaa 
rakennetun ympäristön tarjoamaa hyvinvoinnin potentiaalia eri alueilla yleisemmin. Perinteisistä 
monitavoitearviointiprosesseista poiketen lähtökohtana on ollut luoda yksinkertaistettu menetelmä, joka 
auttaisi organisaatioiden omassa strategiatyössä myös jatkossa. Tavoitteena on, että tämän 
koulutusmateriaalin avulla menetelmä voidaan toistaa itsenäisesti kunnassa tai seutuorganisaatiossa 
esimerkiksi strategisten painopisteiden vaihtuessa. Työkalu soveltuu käytettäväksi niin yksittäisen kunnan 
kuin kaupunkiseudunkin näkökulmasta. Mittakaava huomioidaan mm. arvopuun kriteereiden ja 
paikkatietoaineistojen valinnassa. 
 
Menetelmän tärkein osa on ns. arvopuun laatiminen, jossa päätetään osa-alueet eli kriteerit, joiden suhdetta 
tavoitteiden toteuttamiseen mitataan (kuva 1). Nämä kriteerit valitaan ja pisteytetään työpajoissa yhdessä 
eri toimijoiden kanssa. Keskeinen osa menetelmää on myös keskustelu eri kunnan hallintoalueiden 
asiantuntijoiden kesken, jotta kaikki hyvinvointiin liittyvät näkökulmat huomioidaan ja löydetään yhteinen 
ymmärrys arvopuun sisällöstä. Menetelmässä arvopuun kutakin alimman hierarkiatason kriteeriä vastaa 
paikkatietoaineisto tai aineistoyhdistelmä (usean paikkatietoaineiston yhdistelmäkarttataso), minkä takia 
prosessin alusta asti mukaan tarvitaan asiantuntemusta paikkatiedosta (GIS). Kutakin kriteeriä kuvaava 
paikkatietoaineisto esikäsitellään, ja niihin yhdistetään työpajoissa annetut pisteytykset. Lopuksi 
pisteytyksillä painotetut yksittäiset karttatasot asetetaan päällekkäin ja yhdistetään, jolloin saadaan 
visualisoitua karttataso, joka näyttää eri alueiden tarjoaman hyvinvointipotentiaalin suhteessa valittuihin 
tavoitteisiin, kriteereihin sekä annettuihin pisteytyksiin. Menetelmän eri vaiheet ja niiden ohjeistus on 
avattu tarkemmin luvussa 2. 
 
Menetelmässä on syytä huomioida, että sillä ei päästä kiinni ihmisten todelliseen hyvinvointiin kullakin 
alueella, vaan sen tarkoitus on kartoittaa rakennetun ympäristön mahdollistamaa hyvinvointipotentiaalia eri 
alueilla. Sosioekonomiset tekijät (esim. asukkaiden ikärakenne, koulutus- ja tulotaso jne.) on tarkoituksella 
rajattu tästä tarkastelusta pois. Näitä tekijöitä kannattaa kuitenkin tarkastella erikseen ja verrata tuloksia 
tämän menetelmän tuottamiin potentiaalitarkasteluihin. 
 
  



Menetelmä on joustava ja muuntautuva, minkä takia sitä voi soveltaa hyvin erilaisiin suunnittelun tarpeisiin. 
Lähtökohtana on, että suunnittelukysymystä vastaavat osa-alueet eli kriteerit valitaan tarkastelukohteen 
mukaan ja suhteessa asetettuihin tavoitteisiin.  Tarkoituksena on, että suunnittelukysymykseen vaikuttavia 
tekijöitä ei ohjailla ylhäältä päin, vaan kriteerit nousevat alueen toimijoiden omista tarpeista ja tavoitteista 
käsin. Menetelmän ideana onkin, että tietyn yhteisön muodostamat arvot muuntuvat kartalle. Kriteerien 
valinnassa on tärkeä perehtyä riittävästi suunnittelukysymyksen taustoihin esimerkiksi 
tutkimuskirjallisuuden avulla. Hyvinvoinnin suunnittelun lisäksi menetelmää voi soveltaa erilaisissa 
strategisissa suunnittelukysymyksissä, esimerkiksi: 

• asuntopoliittiset ohjelmat 
• ympäristöohjelmat 
• alueiden kehittämissuunnitelmat 
• erilaiset yhteissuunnitelmat eri toimialojen välillä 
• luonto- ja viheralueiden arvottaminen 
• kaavoitus ja maankäytön suunnittelu 

 
 
 
 

 
Kuva 1. Pirkkalan kunnan tutkijoiden avustuksella laatima arvopuu, johon on koottu tavoitteita vastaavat kriteerit 
kahdella eri hierarkiatasolla. 
 
 



2 Menetelmän vaiheet 
 
Menetelmä jakautuu viiteen osakokonaisuuteen: 

1) Menetelmään tutustuminen ja arvopuun laatiminen 
2) Käytettävien paikkatietoaineistojen selvittäminen ja tarkistus  
3) Kriteereiden kuvaustavan ja kynnysarvojen valinta 
4) Arvopuun pisteytys  
5) Paikkatietoanalyysit 

 
Vaiheet 1, 3 ja 4 kannattaa toteuttaa kokous- tai työpajamuodossa. Vaiheet 2 ja 5 vaativat organisaation 
paikkatietoaineistojen ja -menetelmien tuntemista ja hallintaa, minkä takia niissä tarvitaan erityisesti 
paikkatietoasioista vastaavan henkilön / henkilöiden itsenäistä työtä. 
 
2.1 Menetelmään tutustuminen ja arvopuun laatiminen 
 
StrateGIS-menetelmä aloitetaan siten, että 
tunnistetaan prosessiin osallistuvat henkilöt. 
Osallistujien määrälle ei periaatteessa ole 
ylärajaa, mutta osallistujajoukko on 
yhteiskeskustelun toimivuuden kannalta hyvä 
rajata n. 15 henkilöön. Osallistujien olisi hyvä 
edustaa mahdollisimman erityyppistä 
asiantuntemusta, joilla kuitenkin on kytkös 
hyvinvointiin. Täten mahdollisimman laaja 
asiantuntemus ja erilaiset näkökulmat tulevat 
huomioiduksi. Paikkatietoasiantuntemuksen 
mukanaolo on menetelmän soveltamisen 
edellytys. Kannattaa myös kiinnittää 
huomiota siihen, että osallistujajoukko 
pysyisi mahdollisimman samana koko 
prosessin ajan. Tämä takaa sen, että kaikilla 
osallistujilla on yhteneväinen ymmärrys 
menetelmästä ja heillä on mahdollisuus antaa 
panoksensa työhön arvopuun työstämisestä 
aina pisteyttämiseen asti. Tämä takaa yleensä 
myös parhaimman lopputuloksen. 
 
Menetelmään tutustumiseksi osallistujille 
jaetaan tämä dokumentti sekä menetelmää 
esittelevä pdf-tiedosto liitemateriaaleineen ja 
niistä kannattaa keskustella yhdessä 
osallistujien kesken, jotta kaikki ymmärtävät 
prosessin, johon ollaan ryhtymässä.  
 
Arvopuuta kannattaa lähteä työstämään 
tutkimuskirjallisuudessa esiin nousevien 
hyvinvointi-indikaattoreiden avulla, joita on listattu alalukuun 2.1.1. Tämän vaiheen voi tehdä osallistujien 
yhteisenä työpajana tai työpajojen ja kokousten sarjana (kuva 2). Kuvassa 3 on esitetty esimerkki työpajan 
/ työpajojen mahdollisesta vaiheistamisesta. Arvopuun laatimisen ensimmäinen vaihe on 
kokonaistavoitteen määrittäminen. Se kannattaa muotoilla yhdeksi lauseeksi. Samassa yhteydessä kannattaa 
keskustella hyvinvoinnin määritelmästä: miten osallistujat käsittävät hyvinvoinnin. Yhteisen ymmärryksen 
luominen peruskäsitteistä auttaa myös keskustelussa kriteereiden valinnasta ja alemman tason tavoitteiden 
määrittelystä. 
 

Kuva 2. Kriteereiden ryhmittelyä ja pohdintaa Tampereen 
seudun ensimmäisessä työpajassa 24.10.2019. 



 

 
Kuva 3. Arvopuun työstämisen vaiheet, jotka kannattaa toteuttaa työpajana / kokouksena tai niiden sarjana. 
 
Taulukkoon 1 on koottu kriteereiden valinnassa huomioon otettavia asioita. Spatiaalisessa 
monitavoitearvioinnissa kannattaa kiinnittää huomiota erityisesti arvopuun kriteereiden mitattavuuteen, 
operationalisuuteen, arvopuun symmetrisyyteen sekä toiston välttämiseen. Arvopuuhun ei voi ottaa sellaista 
kriteeriä, jota ei pysty mittamaan käytössä olevalla paikkatietoaineistolla tai jos aineisto on laadultaan tai 
tarkkuudeltaan riittämätön. Paikkatietoaineistojen käsittely menetelmässä vievät melko paljon aikaa, minkä 
takia suurta manuaalista aineiston tuotantoa vaativia kriteereitä kannattaa välttää. Symmetrisyydellä 
tarkoitetaan sitä, että arvopuun haaroissa tulee olla suurin piirtein saman verran kriteereitä. Ei ole olemassa 
selkeitä sääntöjä sille, kuinka monen kriteerin ero on sallittu, mutta nyrkkisääntönä voi pitää sitä, että 
saman hierarkiatason eri haarat poikkeaisivat toisistaan korkeintaan kahdella (2) kriteerillä suuntaan tai 
toiseen. Yksi tekijä tulisi olla mukana arvopuussa vain yhden kerran, eli kriteereiden käsitteellistä 
päällekkäisyyttä tulee välttää, jotta jokin yksittäinen tekijä ei ylikorostu pisteytyksessä. Arvopuun haarat 
kannattaa lopuksi myös tarkistaa siitä näkökulmasta, että yksittäisten haarojen tekijöitä on mielekäs 
arvottaa suhteessa toisiinsa. Tämä helpottaa pisteytystä. 
 
Kriteereiden nimeämisessä kannattaa huomioida vaikutuksen suunta, mikä helpottaa pisteytystä. 
Esimerkiksi kriteeri ”risteysten määrä” kannattaa muotoilla ”suuri risteysten määrä”. Tällöin pisteytyksessä 
on selkeämpää, arvottaako suurta ja pientä risteysten määrää. 
 
Tarkastelumittakaava tulee ottaa huomioon niin kriteereiden kuin paikkatietojen valinnassakin. Esimerkiksi, 
jos tehdään omaan kuntaan rajautuvaa tarkastelua, on mielekästä ottaa mukaan arvopuuhun vain sellaisia 
tekijöitä, joihin kunnan omalla suunnittelulla voi vaikuttaa. Sama koskee seutumittakaavaa: jos kriteeristä 
(esim. tiettyjen palveluiden järjestämisestä) päätetään vain kuntatasolla, kriteeriä ei kannata ottaa mukaan 
seudulliseen tarkasteluun. Samaa kriteeriä voi käyttää sekä kunta- että seututasolla, mutta sitä voidaan 
kuvata hieman erilaisella paikkatietoaineistolla. Esimerkiksi virkistysalueiden saavutettavuus -kriteeriä 
voidaan kuvata kuntatasolla lähivirkistysalueita kuvaavalla aineistolla ja seututasolla vain seudullisesti 
merkittäviä virkistysalueita kuvaavalla aineistolla (esim. kansallispuistot sekä muut laajemmat virkistykseen 
soveltuvat alueet). Myös samaa aineistoa voi käyttää säätämällä viheralueiden vähimmäiskoot 
tarkastelumittakaavaan sopivaksi. 
  

VAIHE 1. Kokonaistavoitteen määrittely 
• Määritellään yhdessä keskustellen arvopuulle kokonaistavoite – mitä tavoitellaan? 

 
VAIHE 2. Esiselvitettyjen kriteereiden ja indikaattorien ryhmittely 

• Kriteerit ryhmitellään yhdessä keskustellen temaattisiksi kokonaisuuksiksi. Jo tässä vaiheessa 
on hyvä kiinnittää huomiota siihen, että kriteereitä on ryhmissä suurin piirtein saman verran 
(+-2) 
 

VAIHE 3. Kriteeriryhmien nimeäminen ja tavoitteiden asettaminen 
• Ideoidaan kriteeriryhmille nimet sekä niitä vastaavat alatavoitteet 

 
VAIHE 4. Arvopuun viimeistely 

• Karsitaan arvopuun kriteereitä sen mukaan, onko niitä kuvaavia paikkatietoaineistoja 
olemassa tai tuotettavissa ja ovatko kriteerit relevantteja tarkasteltavalla alueella 

• Arvopuuta voi myös täydentää uusilla kriteereillä siten, että lopputulos on kriteereiden 
suhteen symmetrinen 

• Jos kriteereitä on hyvin paljon, kriteereistä voi muodostaa myös kolmannen hierarkiatason 
analyysiin, kuten Tampereen seudun arvopuussa päädyttiin tekemään 



Taulukko 1. Kriteereiden valinnassa huomioon otettavia asioita (Keeney & Gregory 2005 pohjalta). 

Asiaankuuluvuus  Kriteerit ovat relevantteja mitattavan arvon suhteen. 

Ymmärrettävyys Kaikki ymmärtävät kriteerin ja käsittävät sen samalla tavoin. 

Mitattavuus  Tarkasteltavan kriteeriä on mahdollista määrittää paikkatietoaineistolla. 

Toiston 
välttäminen Samaa asiaa ei mitata usealla kriteerillä. 

Täydellisyys Tarkastelussa on mukana kaikki asiaan vaikuttavat seikat. 

Operationaalisuus Tarvittava tieto on kohtuullisin ponnistuksin hankittavissa. 

Yksinkertaisuus Tarkasteluun sisällytetään vain niin paljon tekijöitä kuin ongelman kuvaamisen kannalta on tarpeen. 

Symmetrisyys Erilaisten kriteerien painottamiseen liittyvien harhojen välttämiseksi on syytä välttää arvopuita, 
joissa eri hierarkiahaaroissa on hyvin erilukuinen määrä kriteereitä. 

 
 

2.1.1 Hyvinvointia kuvaavia kriteerejä ja indikaattoreita 
 
Taulukkoon 2 on listattu HYMY-hankkeessa tutkimuskirjallisuuden tai kuntien omista tarpeista esiin 
nousseita rakennetun ympäristön hyvinvointitekijöitä. Näitä indikaattoreita voi hyödyntää pohjana 
arvopuun päivittämiseen myös jatkossa. On hyvä huomioida, että listattuja indikaattoreita voidaan kuvata 
paikkatietoaineistoilla hyvin eri tavoin riippuen mm. aineistojen saatavuudesta. Tarkempia kuvauksia 
indikaattoreiden kuvaustavoista on esitetty eri HYMY-kuntien arvopuiden yhteydessä liitemateriaalissa. 
Esimerkki kriteerin tarkemmista kuvaustavoista on esitetty kuvassa 4. 
 
Taulukon 2 indikaattoreista osaa on tutkittu tutkimuskirjallisuudessa huomattavasti enemmän kuin toisia. 
Tämä ilmenee taulukon oikeanpuolimmaisen sarakkeen viitteiden määrässä. Taulukon pohjalta voidaan 
tulkita, että tietyt, paljon tutkitut ja yleisesti käytössä olevat indikaattorit, kuten virkistysalueiden tai 
vesistöjen läheisyys lisäävät alueiden tarjoamaa hyvinvointipotentiaalia. Tällöin indikaattorin voidaan ajatella 
olevan käyttökelpoinen alueesta riippumatta. Indikaattorin tieteellinen vahvuus ei kuitenkaan ole ainoa 
kriteeri, jolla arvopuun indikaattoreita kannattaa valita. Suomalaisetkin kunnat ovat keskenään hyvin 
erilaisia (mm. kaupunki-/maaseutumaisuus, väestömäärä, ilmasto, jne.), minkä takia paikallisista olosuhteista 
nousevat hyvinvointitekijät kannattaa ehdottomasti huomioida indikaattoreita valittaessa Alueiden 
erilaisuudesta johtuen tietyt indikaattorit eivät välttämättä suoraan sovellu kuvamaan toisen alueen 
hyvinvointitekijöitä. 
 
  
 
  



Taulukko 2. HYMY-hankkeiden arvopuissa esiintyviä kriteereitä.  

Kriteeri 

Pääasiallinen 
mittakaava 
(K=kunta, 
S=seutu) 

Indikaattoria tutkittu, kehitetty tai 
sovellettu mm. seuraavissa 

julkaisuissa 

Oppilaitosten saavutettavuus K / S Duncan ym. 2015; Strandell 2017 
Kulttuuri- ja vapaa-ajan palveluiden saavutettavuus K / S Söderman & Saarela 2011 

Lähikaupan saavutettavuus K / S Handy ym. 2002; Strandell 2017; 
Rehunen ym. 2018 

Sosiaali- ja terveyspalveluiden saavutettavuus K / S Rashidfarokhi ym. 2018; Wang 2012 
Päiväkotien saavutettavuus K Strandell 2017 

Liikuntapalveluiden saavutettavuus K / S 
Brennan Ramirez ym. 2006; Sallis ym. 
2006; Abraham ym. 2010; Söderman & 
Saarela 2011; Gehl 2018 

Leikkipaikkojen saavutettavuus K / S Abraham ym. 2010; Gehl 2018; Reimers 
ym. 2018 

Ulkoilureitit K / S Maes ym. 2014; Cortinovis ym. 2018; 
Laatikainen ym. 2018 

Lähivirkistysalueiden saavutettavuus K 
Brennan Ramirez ym. 2006; Sallis ym. 
2006; Söderman & Saarela 2011; Wolch 
ym. 2014; Garau & Pavan 2018 

Laajat metsäalueet S Söderman & Saarela 2011 

Katuvihreä K 
Brennan Ramirez ym. 2006; Söderström 
2012; Laatikainen ym. 2017; Garau & 
Pavan 2018; Gehl 2018 

Perinneympäristöt, harvinaiset biotoopit K / S Raatikainen 2018 

Vesistön läheisyys K / S 
Depledge & Bird 2009; White ym. 2010; 
Laatikainen 2017; Samuelsson ym. 2018; 
Viinikka ym. 2018 

Vesistöihin liittyvät palvelut K / S Työpajassa alueellisesti tunnistettu 
kriteeri 

Julkinen taide K / S Brennan Ramirez ym. 2006; Söderström 
2012; Rashidfarokhi ym. 2018 

Alhainen melutaso (esim. tie-, rautatie-, lento- ja 
teollisuusmelu) K / S Söderman & Saarela 2011; Von 

Szombathely ym. 2017; Gehl 2018; 

Hyvä ilmanlaatu (alhainen pienhiukkaspitoisuus) K / S 

Sallis ym. 2006; Söderman & Saarela 
2011; Von Szombathely ym. 2017; 
Garau & Pavan 2018; Batten 2018; Gehl 
2018;  

Hyvä vedenlaatu K / S Söderman & Saarela 2011 
Ei pilaantuneita maa-alueita K / S Northridge 2011; Steffan ym. 2018 
Rakennetut kulttuuriympäristöt K / S Garau & Pavan 2018; Rehunen ym. 2019 
Arvokkaat maisema-alueet K / S Gehl 2018 
Asuinalueet, joille laadittu rakentamistapaohjeet tai olleet 
arkkitehtuurikilpailun kohteena (arkkitehtuurin ilme / laatu) K Handy ym. 2002; Sallis ym. 2006; 

Strandell 2017 
Kokoontumispaikat (esim. torit, aukiot, asukastuvat, 
kerhotilat) K / S Söderström 2012 

Joukkoliikenteen palvelutaso (mm. vuorotiheys, kävelyetäisyys 
pysäkille) K / S 

Sallis ym. 2006; Söderman & Saarela 
2011; Laatikainen 2018; Urban Mobility 
Indicators… 2019 

Kävelyn ja pyöräilyn väylien palvelutaso K / S Gehl 2018; Söderström 2012 

Hyvä liikenneturvallisuus K / S Abraham ym. 2010; Söderman & Saarela 
2011; Gehl 2018; Strandell 2017 

Alueen turvallisuus (esim. katuturvallisuusindeksi) K / S Sallis ym. 2006 

Monipuolinen asuntojen hallintamuotojakauma K / S Söderman & Saarela 2011; Saikkonen 
ym. 2018 

Talotyyppien monipuolisuus K / S Saikkonen ym. 2018 
Huoneistotyyppien monipuolisuus K / S Saikkonen ym. 2018 
Asuntojen kohtuullinen hintataso K / S Söderman & Saarela 2011 
Asuntojen kohtuullinen vuokrataso K / S Söderman & Saarela 2011 

Olemassa oleva vesihuoltoverkosto K / S Työpajassa alueellisesti tunnistettu 
kriteeri 



Kulkuväylien valaistus K / S Ahlgren-Leinvuo 2017; Gehl 2018; 
Garau & Pavan 2018 

Tieverkon yhdistävyys K / S 
Handy ym. 2002; Sallis ym. 2006; Gehl 
2018; Laatikainen ym. 2018; Abraham 
ym. 2010 

Kevyen liikenteen väylätiheys K / S Sallis ym. 2006; Brennan Ramirez ym. 
2006; Abraham ym. 2010 

Tietoverkkopalvelut julkisessa palvelupisteessä K / S Batten 2018; Rashidfarokhi ym. 2018 
Kaupunkipyörät K  Jäppinen 2012; Batten 2018 

Luonnonsuojelualueet K / S Söderman & Saarela 2011; Maes ym. 
2014 

Alhainen radonpitoisuus K / S Työpajassa alueellisesti tunnistettu 
kriteeri 

Väylien hyvä kunnossapito K / S Ahlgren-Leinvuo 2017; Gehl 2018; 
Urban Mobility Indicators 2019 

Etäisyys keskustaan / keskusverkkoon K / S Foster ym. 2019 
Yhdyskuntarakenteen sekoittuneisuus (esim. väestön ja 
työpaikkojen tasainen jakauma; rakennusten 
käyttötarkoituksen sekoittuneisuus tai yritysten toimialojen 
monipuolisuus) 

K / S 

Handy ym. 2002; Brennan Ramirez ym. 
2006; Sallis ym. 2006; Abraham ym. 
2010; Söderman & Saarela 2011; 
Söderström 2012 

Matkaketjujen sujuvuus (esim. liityntäpysäköintialueen tai 
pyöräparkin läheisyys) K / S Urban Mobility Indicators 2019 

Penkkien määrä K Brennan Ramirez ym. 2006; Söderström 
2012; Gehl 2018;  

Alhainen ahtaasti asuvien osuus K / S Söderman & Saarela 2011 
Asemanseutujen saavutettavuus K / S Brennan Ramirez ym. 2016 
Joukkoliikenteen / henkilöautoilun vuosikustannus K / S Urban Mobility Indicators 2019 

Loma- ja matkailualueet S Työpajassa alueellisesti tunnistettu 
kriteeri 

 
 
 
2.2 Käytettävien paikkatietoaineistojen selvittäminen ja tarkistus 

Jokaista arvopuun kriteeriä kuvataan paikkatietoaineistolla tai aineistoyhdistelmällä, mikä mahdollistaa 
tulosten tarkastelemisen kartalla ja aluekohtaisen vertailun. Jos kriteeriä vastaavaa aineistoa ei ole saatavilla 
paikkatietomuodossa, sitä ei voida ottaa mukaan tarkasteluun.  Tästä syystä paikkatietoaineistojen 
saatavuus on hyvä pitää mielessä läpi prosessin.  

Paikkatietoaineistojen hankkiminen ja esikäsittely menetelmään sopiviksi on melko aikaa vievää, joten 
niiden saatavuuden selvittely kannattaa aloittaa heti kriteerien valitsemisen yhteydessä. Organisaation 
paikkatietoasiantuntijalla on tässä iso rooli, joten onkin suositeltavaa, että paikkatietoasiantuntija on 
mukana alusta asti. Käytettävän aineiston tulisi olla mahdollisimman yhteneväinen tarkkuuden ja 
keräysajankohdan osalta ja sen tulisi kattaa koko tutkimusalue. Heikkolaatuinen aineisto voi pahimmassa 
tapauksessa johtaa vääriin tuloksiin ja tulkintoihin. Aineistojen laadun arvioinnissa auttavat esimerkiksi 
aineiston metatiedot, jotka on hyvä käydä lävitse ennen kuin sitä käytetään analyyseihin, sekä 
paikallistuntemus. Aineistoja voidaan esimerkiksi avata paikkatieto-ohjelmassa ja arvioida sen laatua 
taustakarttaa vasten suhteessa paikallistuntemukseen. 

Yksi iso tekijä paikkatietoaineiston valinnassa on tutkimusalueen mittakaava, joka määrittää tarvittavan 
aineiston tarkkuuden. Kuntakohtaisessa tarkastelussa voi hyödyntää kunnan omien paikkatietoaineistojen 
lisäksi valtakunnallisia aineistoja soveltuvin osin. Jos mittakaava on kuntaa tarkempi, valtakunnalliset 
aineistot eivät välttämättä enää sovellu analyyseihin niiden karkeuden takia, vaan tällöin on turvauduttava 
tarkempiin, kunnan omiin aineistoihin. Jossain tapauksissa on mahdollista tuottaa myös uusia aineistoja, jos 
se on aikataulullisesti ja resurssien osalta mahdollista. 

Yhä useampi organisaatio on avannut paikkatietoaineistoja kaikkien saataville. Taulukkoon 3 on koottu 
esimerkkejä avoimista aineistoista, joista voi aloittaa tarvittavien aineistojen etsimisen kunnan omien 
aineistojen lisäksi. 
 



Taulukko 3. Linkkejä hyödynnettäviin paikkatietoaineistoihin 

Organisaatio Linkki avoimiin paikkatietoaineistoihin 

Suomen ympäristökeskus (SYKE) https://www.syke.fi/fi-FI/Avoin_tieto/Paikkatietoaineistot  
Maanmittauslaitos (MML) https://tiedostopalvelu.maanmittauslaitos.fi/tp/kartta 
Metsäkeskus https://www.metsaan.fi/paikkatietoaineistot 
LIPAS (Jyväskylän yliopisto) https://www.lipas.fi/liikuntapaikat 
Väylä https://vayla.fi/avoindata 
Tilastokeskus (TK) https://www.stat.fi/org/avoindata/paikkatietoaineistot.html 
Digi- ja väestötietovirasto https://www.avoindata.fi/data/fi/dataset/postcodes  

 

2.3 Kriteereiden kuvaustavan ja kynnysarvojen valinta 
 
Kun arvopuun rakenne ja mukaan otettavat kriteerit on valittu, kriteereiden kuvaustapaa täytyy vielä 
tarkentaa paikkatietonäkökulmasta. Pisteytyksen mielekkyyden kannalta on esimerkiksi tärkeää tietää se, 
mitkä palvelut ovat mukana sosiaali- ja terveyspalveluiden saavutettavuus- tai Kohtaamispaikat -kriteereissä. 
Kriteerien muodostamistapa paikkatietonäkökulmasta vaikuttaa myös kunkin kriteerin sisältöön. 
Kriteereiden tarkemmat kuvaukset kannattaa koosta esim. taulukkomuotoon arvopuun haaroittain niin 
tarkasti kuin mahdollista (esimerkki kuvassa 4). Tämän raportin liitteenä on toimitettu kaikkien HYMY-
hankkeen kuntien arvopuut, joiden yhteydessä myös kriteereiden tarkemmat kuvaukset. 
 

 
Kuva 4. Esimerkki kriteereiden tarkemmista kuvauksista ja käytettävistä aineistoista Lahden arvopuun haarasta 
”Luontoliikkumista edistävä ympäristö”. 
 
Saavutettavuuksia tarkastelevien kriteereiden osalta on syytä määritellä, mihin asti kriteerin 
hyvinvointivaikutuksen halutaan kartalla rajoittuvan. Tyypillisin esimerkki tästä ovat erilaisten palveluiden 
saavutettavuudet; mikä on hyväksyttävä etäisyys erilaisille palveluille, jotta sillä on merkitystä 
hyvinvointinäkökulmasta? Näitä raja-arvoja voidaan kutsua myös kynnysarvoiksi. Kynnysarvoilla (thresholds) 
tarkoitetaan sellaista arvoa, jossa ekologinen tai sosioekonominen systeemi muuttuu nopeasti tilasta 
toiseen (Kato & Ahern 2011). Ympäristötaloustieteessä kynnysarvojen määrittäminen on enemmänkin 
yhteydessä optimiarvojen hakemiseen – yhteiskunnalle aiheutuvien hyötyjen ja kulujen tasapainoon 
(Bertrand ym. 2008). Rakennetun ympäristön kontekstissa voidaan puhua esimerkiksi mahdollisimman 
kestävien ratkaisujen etsimisestä. Kun puhutaan alueiden suunnittelusta, kynnysarvot muuntuvat usein 
poliittisiksi tavoitteiksi tai sosiaalisiksi preferensseiksi, jolloin kynnysarvoja tulisi kutsua ennemminkin 
tavoitteiksi (targets).  
 
Parhaimmillaan tutkimuksella määritellyt kynnysarvot muuntuvat suunnittelun tavoitteiksi. Kaikista 
rakennetun ympäristön tekijöistä ei ole kuitenkaan saatavilla kattavaa tutkimustietoa. Kynnysarvot eivät 
myöskään ole universaaleja, vaan paikalliset olosuhteet: luonnontieteelliset sekä kulttuurilliset tekijät 
vaikuttavat niihin. Siksi paikallisten olosuhteiden tunnistaminen on tarpeen kynnysarvojen määrittämiseksi. 

https://www.syke.fi/fi-FI/Avoin_tieto/Paikkatietoaineistot
https://tiedostopalvelu.maanmittauslaitos.fi/tp/kartta
https://www.metsaan.fi/paikkatietoaineistot
https://www.lipas.fi/liikuntapaikat
https://vayla.fi/avoindata
https://www.stat.fi/org/avoindata/paikkatietoaineistot.html
https://www.avoindata.fi/data/fi/dataset/postcodes


Hyvinvointinäkökulmasta tutkimus ihmisten käyttäytymisestä rakennetussa ympäristössä tuottaa 
hyödyllistä tietoa kynnysarvojen pohjaksi. Esimerkiksi Asukasbarometrissä (Strandell 2017) on tutkittu 
etäisyyden vaikutusta matkojen kulkutapaan kaupan- ja koulumatkoilla. Sen perusteella kävelyn osuus 
matkoista vähenee selvästi, kun etäisyys kauppaan on 500 m. Lasten kyyditseminen autolla taas lisääntyy, 
kun koulumatka on yli 1 km. Lähivirkistysalueiden osalta kotiovelta luontoon tulisi olla enintään 300 metrin 
etäisyys tai 5–10 minuutin kävelymatka. Tutkimusten mukaan tätä pidempi matka vähentää 
virkistysalueiden käyttöä (Coles & Bussey 2000; Schipperijn ym. 2010).  
 
Kannattaa kiinnittää huomiota siihen, että kynnysarvot määritetään asetettujen tavoitteiden mukaisiksi. Jos 
esimerkiksi arvopuun haaran tavoitteena on ”lihasvoimalla liikkumisen tukeminen”, kynnysarvoja ei kannata 
asettaa pidemmiksi kuin suotuisa pyöräilyetäisyys, esim. 5 km. Etäisyyksiä voi paikkatietovalmiuksista 
riippuen laskea joko linnuntienä (hyvä lyhyille etäisyyksille), tieverkkoa pitkin (antaa realistisemman kuvan, 
jos etäisyydet ovat kilometrejä) tai matka-aikoina (kulkutavan mukaan määriteltynä). Saavutettavuuksien 
laskennasta paikkatieto-ohjelmassa on kerrottu tarkemmin liitteessä 2. 
 

2.4 Arvopuun pisteytys 
 
Osallistujat pisteyttävät lopullisen arvopuun kunkin kriteerin suhteessa saman hierarkiatason kriteereihin 
ja ylemmän hierarkiatason tavoitteeseen. Pisteytys tehdään yksi hierarkiataso tai arvopuun haara 
kerrallaan. Jokainen osallistuja pisteyttää arvopuun itsenäisesti paperille, jolloin saadaan esiin kaikkien 
osallistujien oma näkemys kunkin kriteerin tärkeydestä. Itsenäisellä pisteytyksellä pyritään välttämään 
konsensushakuiseen ryhmäajatteluun (groupthinking) liittyviä ongelmia sekä yksittäisten äänekkäiden 
näkemysten dominointia. Pisteytys noudattaa asteikkoa 1–10, jossa arvo 10 tarkoittaa tärkeintä arvoa. 
Osallistujia kannustetaan käyttämään koko pisteytysasteikkoa, jolloin saadaan myös eroja lopullisiin 
arvoihin. Arvopuun haaran kriteereille voi myös antaa samat pisteet, jos niiden välisestä tärkeydestä on 
mahdotonta tehdä eroa. Kaikkien osallistujien pisteet kootaan lopuksi tämän raportin yhteydessä 
toimitettuun Excel-laskuriin.  
 
Pisteytykset kumuloituvat ylemmältä hierarkiatasolta alimmalle kriteerille tulona (kuva 5).  Kutakin 
alimman hierarkiatason kriteeriä kuvataan soveltuvalla paikkatietoaineistolla, johon pisteet liitetään. 
Pisteistä voidaan laskea erilaisia tunnuslukuja kriteereille, kuten keskiarvo tai mediaani, jotka kuvastavat 
pisteyttäjien keskimääräistä näkemystä kriteerin tärkeydestä. Excel-laskurista saadaan sekä mediaanit että 
keskiarvot syötetyille pisteille. Jos osallistujia on hyvin vähän, keskiarvo on paras keskiluku pisteytyksille. 
Mediaani taas soveltuu paremmin, jos pisteyttäjiä on paljon ja poikkeavien pisteiden vaikutusta 
loppupisteisiin halutaan vähentää. 
 
Pisteiden liittäminen paikkatietoaineistoihin on automatisoitu ja se sisältyy paikkatietotyökaluun, joka on 
kuvattu tarkemmin luvussa 2.5.3 Pisteytysten yhdistäminen paikkatietoaineistoihin. 
 



 
 

Kuva 5. Arvopuu pisteytetään hierarkiatasoittain ylhäältä alas ja vasemmalta oikealle edeten. Kukin kriteeri 
pisteytetään suhteessa ylemmän hierarkiatason tavoitteeseen. Tässä esimerkissä ensin pisteytetään kriteerit 
”toimiva yhdyskuntarakenne”, ”pehmeä ympäristö”, ”stimuloiva vapaa-aika” ja ”viisas liikkuminen” suhteessa 
kokonaistavoitteeseen. Tämän jälkeen pisteytys jatkuu alemmalle hierarkiatasolle yksi puun haara kerrallaan. 
Esimerkiksi kriteerit ”yhdyskuntarakenteen sekoittuneisuus”, ”talotyyppien monipuolisuus”, ”alhainen lentomelu” 
ja ”huoneistotyyppien monipuolisuus” pisteytetään suhteessa kriteerin ”toimiva yhdyskuntarakenne” 
tavoitteeseen ”Monimuotoinen ja turvallinen ympäristö”. Kuinka tärkeä kukin tämän haaran kriteereistä on 
suhteessa monimuotoisen ja turvallisen ympäristön luomiseen? Lopullinen pistemäärä kumuloituu tulona 
korkeammalta hierarkiatasolta alemmalle tasolle. 

 

  



2.5 Paikkatietoanalyysit  
 
Tässä luvussa ohjeistetaan tarkemmin menetelmässä tarvittavia paikkatietoanalyysejä. Analyysit on jaettu 
kolmeen osaan: 

• Tarvittavien paikkatieto-ohjelmien lataus ja asennusohje 
• Paikkatietoaineistojen esikäsittelyvaihe 
• Työkalu pisteiden yhdistämiseksi paikkatietoaineistoihin 

 
2.5.1 Ohjelmistot ja niiden lataaminen sekä asennus 
 

 
Tässä esimerkissä ohjelmat on asennettu D-levylle Program Files-kansioon, mutta se ei ole välttämätöntä.   
 
Qgis-paikkatieto-ohjelman asennus 

Qgis-ohjelman voi ladata osoitteesta: 
https://qgis.org/en/site/forusers/download.html#  
 
Windows-käyttäjän kannattaa valita Long term release repository (most stable): QGIS standalone installer version 
3.4. Kyseinen versio on vakain saatavilla oleva versio, joka sisältää R-lisäosan. Tämä mahdollistaa R-skriptiin 
pohjautuvan työkalun hyödyntämisen suoraan QGIS-ohjelmistosta käsin. R-ohjelma tulee olla asennettuna 
ennen QGIS-lisäosan asennusta.  
 
R-ohjelman asennus 

R-ohjelmiston voi ladata osoitteesta: 
https://cran.r-project.org/bin/windows/base/old/3.5.0/   
Työkalu on yhteen sovitettu R version 3.5.0 kanssa, mutta toimii myös uudempien versioiden kanssa. 
Riippuen Windowsin versiosta lataa 32/64-bittinen R.  

 
Tämän lisäksi voit halutessasi ladata R-studion (suositus), joka helpottaa R-työskentelyä: 
https://rstudio.com/products/rstudio/download/#download  
R-studio käyttää lataamaasi R-ohjelmaa ja tarjoaa siihen mm. analysointia helpottavia työkaluja ja lisää 
käyttömukavuutta. 
 
R-ohjelman linkitys QGIS-ohjelmaan 

Esimerkeissä QGIS:n oletuskieli on englanti. Oletuskielen voi vaihtaa QGIS:n valikosta asetukset > yleiset > 
käyttöliittymän kielisyys (American English). Tämän jälkeen ohjelma tulee avata uudestaan, jotta kielenmuutos 
astuu voimaan.   
 
R-lisäosa ladataan ja asennetaan suoraan QGIS -työpöydän kautta. Avaa QGIS ja valitse plugins > manage 
and install plugins > not installed > processing R provider > install plugin 
 
Konfiguroi yhteys QGIS ja R ohjelman välille: Valitse processing > toolbox > options > processing > providers 
> R ja muokkaa kentät seuraavasti (kuva 6): 

• Package repository: ei tarvitse muuttaa. 
• R folder -> tiedostopolku kansioon, johon R on asennettu (ei R-studio). 
• R script folder: luodaan tiedostopolku kansioon, mihin työkalun R-skripti halutaan tallentaa. 

Suositus samaan kansioon, johon QGIS asennettiin. Lisätietoa R-skriptistä kohdassa Liitteessä 1. 
• Use 64 bit version: laita ruksi, jos käytössäsi on 64-bittinen R. 
• Use user library folder instead of system libraries: laita ruksi ruutuun 
• User library folder: tiedostopolku R-library kansioon, johon latautuu R-kirjastot. Yleensä löytyy 

oletuksena R-kansion alta nimellä Library.  QGIS käyttää ns. ulkoista kirjastoja eli lukee ne 
suoraan tiedostopolusta. Ohjelma ei itse pysty asentamaa kirjastoja. 

https://qgis.org/en/site/forusers/download.html
https://cran.r-project.org/bin/windows/base/old/3.5.0/
https://rstudio.com/products/rstudio/download/#download


 

 
Tämän jälkeen processing toolbox –valikosta pitäisi löytyä R-ikoni. Jos ei, niin avaa plugins > manage 
and install plugins > installed > täppää ruksi Processing R provider 
 

 
Kuva 6. Yhteyden luonti R-ohjelmaan. Tiedostopolut tulee vaihtaa sen mukaan, mihin R:n asennus on tehty. 

 
2.5.2 Aineistojen esikäsittely 
 
Spatiaalista monitavoitearviointia varten jokaisesta kriteeriä vastaavasta paikkatietoaineistosta on 
tuotettava rasteritaso, jonka pikselit istuvat täsmälleen muiden tasojen pikselien kanssa päällekkäin. 
Lopullisten rasteritasojen arvot tulevat aina olla välillä 0–1, jolloin ne ovat yhtenäisiä. Rasterit voidaan 
esikäsitellä esimerkiksi:  

• Binaarimuotoisiksi: pikselit, jotka kuuluvat kuhunkin kriteeriin (esim. suojelualueet) saavat 
arvokseen 1, ja kaikki muut rasterin pikselit saavat arvokseen 0 (esim. suojelualueiden 
ulkopuolelle jäävät alueet) (Kuva 7) 

• Jatkuviksi: pikselit, jotka kuuluvat kuhunkin kriteeriin (esim. etäisyys kouluihin) saavat arvoja 
väliltä 0-1, missä lähimpänä koulua korkeammat arvot 1, jotka laskevat etäisyyden kasvaessa 
kynnysarvoon (esim. 1km) 0. Kaikki muut rasterin pikselit saavat arvokseen 0 (esim. 
etäisyysperusteisen kynnysarvon ulkopuolelle jäävät alueet) (Kuva 8). 

 
Huomioi, että kriteereitä voi olla monenlaisia, jolloin niiden esikäsittelyä voi joutua soveltamaan, 
jotta saadaan arvot skaalattua välille 0-1. Tällaisia voi olla esimerkiksi erilaiset luokituksista koostuvat 
kriteerit, kuten SYKEn yhdyskuntarakenteen vyöhykkeistä koostuva joukkoliikenteen hyvä palvelutaso. 
Tällöin käsittelytapana voi olla esimerkiksi antaa pikseleille, jotka kuuluvat intensiiviseen 
joukkoliikennevyöhykkeeseen arvo 1, joukkoliikennevyöhykkeille arvo 0,5 ja muille alueille arvo 0. 
Korkein arvo kriteerin pisteytyksestä kohdistuu intensiiviseen joukkoliikennevyöhykkeeseen, kun 
joukkoliikennevyöhyke saa 50 % pisteen arvosta. Seuraavassa luvussa on koottu esimerkkejä 
aineistojen esikäsittelyvaiheiden työkaluista QGIS-ohjelmalla. Liite 2 sisältää yksityiskohtaisempia 
kuvauksia paikkatietoanalyyseistä. Huomioi, että aineistot voidaan esikäsitellä paikkatieto-ohjelmasta 
riippumatta.  
 
 



 

 
 

Kuva 7. Esimerkki aineistojen esikäsittelystä: kahdesta erillisestä, mutta samasta kriteeristä kertovasta 
aineistosta on tehty aineistoyhdiste ja muutettu se binaarirasteriksi, jossa kriteeriin kuuluvien alueiden pikselit 
saavat arvokseen 1 ja muiden alueiden pikselit saavat arvokseen 0. 

 

 
 
Kuva 8. Esimerkki aineistojen esikäsittelystä: Oppilaitosten saavutettavuus -kriteeristä muodostettu jatkuva 
rasteripinta. Lähellä koulua pikselit saavat arvokseen 1, josta arvo vähenee etäisyyden kasvaessa 
kynnysarvoon asti ja saa kynnysarvoa pidemmillä etäisyyksillä arvon 0. 

 
 
  



 

Aineistojen muuntaminen binaarirasteriksi [0,1] 
 

1) Varmistetaan, että paikkatietoaineistot ovat yhteneväisessä koordinaatistossa (esim. ETRS-
TM35FIN).  

2) Irrotetaan kriteeriä vastaava paikkatietoaineisto tutkimusalueen rajoille.  
• Esimerkkityökalu 

i. QGIS: Vector > Geoprocessing tools > clip 
3) Jos mukana on useampia aineistoja, jotka kuvaavat kriteeriä, muodostetaan niistä 

aineistoyhdiste.  
• Esimerkkityökalu 

i. QGIS: Vector > Geoprocessing tools > Union 
4) Muutetaan taso rasteriksi (20 m resoluutio on soveltuva kuntakohtaiseen tarkasteluun). 

Tarkastetaan, että pikselit ovat täsmälleen muiden tasojen pikselien kanssa päällekkäin.  
• Esimerkkityökalu 

i. QGIS: Raster > Conversion > Rasterize 
5) Muutetaan aineisto binaarimuotoon [0,1]. Ne pikselit, jotka kuuluvat kriteeriin saavat 

arvokseen 1, ja kaikki muut rasterin pikselit saavat arvokseen 0. Huomioi, että rasterin 
tulee kattaa koko tutkimusalue eikä alueelle saa jäädä NoData-arvoja.  

• Esimerkkityökalu 
i. QGIS: Raster > Raster calculator (syötetään kenttään: ("Rasteri" != 0 )  = 1), 

jolloin kaikki arvot, jotka eivät ole 0, saavat arvon 1 ja 0-arvot pysyvät 0-
arvoina 

 
Aineistojen muuntaminen jatkuviksi rastereiksi [0-1] 
 

1) Varmistetaan, että paikkatietoaineistot ovat yhteneväisessä koordinaatistossa (esim. ETRS-
TM35FIN).  

2) Irrotetaan kriteeriä vastaava paikkatietoaineisto halutulta tutkimusalueelta.  
3) Muutetaan taso rasteriksi (esim. 20 m resoluutio on soveltuva kuntakohtaiseen 

tarkasteluun). Tarkastetaan, että pikselit ovat täsmälleen muiden tasojen pikselien kanssa 
päällekkäin.  

• Esimerkkityökalu 
i. QGIS: Raster > Conversion > Rasterize 

4) Muodostetaan etäisyysvyöhyke  
• Esimerkkityökalu: 

i. QGIS: Raster > Analysis > Proximity  
5) Muutetaan etäisyyspinnan pikselien arvot vastakkaiseksi, jolloin kriteerin läheiset alueet 

saavat korkeamman arvon. 
• Esimerkkityökalu: 

i. QGIS: Raster -> Raster Calculator(syötetään kenttään: 1 - ((”Rasteri” - min) / 
(max - min))) * (max - min) + min 

 
2.5.3 Pisteytysten yhdistäminen paikkatietoaineistoihin 
 
 
Työkalu pisteytysten liittämiseksi esikäsiteltyihin paikkatietoaineistoihin on muodostettu R-
ohjelmointikielellä, ja sitä voidaan käyttää suoraan R-ohjelmassa tai QGIS-ohjelmassa R-lisäosan 
avulla. Työkalun koodi ja sen tarkempi kuvaus on esitetty liitteessä 1 ja se on mukana myös tämän 
dokumentin liitemateriaaleissa. 
 
Työkalun toimintaa varten on koottu esimerkkiaineisto Järvenpään viherrakenteen arvoja kuvaavasta 
kartasta (Kopperoinen ym. 2016: 20). Esimerkkiaineistot pohjautuvat ”Järvenpään viherrakenteen 
arviointi paikkatietomenetelmin (UZ-3 Järvenpää) -hankkeeseen”, joka toteutettiin Suomen 



 

ympäristökeskuksen ja Järvenpään kaupungin yhteistyönä 11/2014 – 12/2015 välisenä aikana. 
Tiedosto sisältää seuraavan kansiorakenteen ja aineistot: 
 
input (kansio) 
Malliin luettavat paikkatietoaineistot, jotka esikäsitelty rasterimuotoon [0-1]. Pikselin arvot lähellä 1 
tarkoittavat korkeampaa tarjontapotentiaalia verrattuna 0-arvoihin: 

• summa_tp.tif: Järvenpään ekosysteemien tuotantopalveluiden tarjonta 
• summa_sp.tif: Järvenpään ekosysteemien säätely- ja ylläpitopalveluiden tarjonta 
• summa_kp.tif: Järvenpään kulttuuristen ekosysteemipalveluiden tarjonta 

 
pisteytetyt (kansio) 
Pisteytetyt paikkatietoaineistot (kriteerit). Malli lukee input kansiosta aineistot ja pisteyttää ne 
pisteytysDEMO.csv –taulukon [Pisteet] sarakkeen perusteella. Pikselin korkeampi arvo tarkoittaa 
viherrakenteen kannalta tärkeämpää aluetta. 

• summa_tp.tif: Järvenpään ekosysteemien tuotantopalveluiden tärkeyttä  
• summa_sp.tif: Järvenpään ekosysteemien säätely- ja ylläpitopalveluiden tarjontaa kuvaava 

rasteripinta 
• summa_kp.tif: Järvenpään kulttuuristen ekosysteemipalveluiden tarjontaa kuvaava 

rasteripinta 
 
output (kansio) 
Tulostiedostot tallentuvat tähän kansioon: 

• summarasteri.tif: Pisteytyksien perusteella muodostettu loppukartta, joka kuvastaa 
viherrakenteen arvoja ekosysteemipalveluiden näkökulmasta 

• summarasteri_n.tif: Pisteytyksien perusteella muodostettu loppukartta, joka kuvastaa 
viherrakenteen arvoja ekosysteemipalveluiden näkökulmasta. Aineisto on normalisoitu 
välille [0-1].  

 
r_skriptit (kansio) 

• smcda.R: R-skripti spatiaalisesta monikriteerimallista. Skripti sisältää tarkemmat ohjeet 
mallin toiminnasta. 

• smcda_qgis.rsx: R-skriptistä muodostettu QGIS-työkalu.  
 
pisteytysDEMO.csv: kriteereitä vastaavien paikkatietoaineistojen nimet ja niitä vastaavat pisteet, sekä 
lyhyt kuvaus aineistosta. Pisteitä muuttamalla tulostuu erilainen loppukartta. Jos pisteitä muutetaan, 
tulee taulukko tallentaa ennen mallin ajoa. HUOM! Aineistonimet tulee vastata täydellisesti input 
kansiossa olevia paikkatietoaineistojen nimiä. 
 
demo.qgz: QGIS-työtila, mistä löytyy demossa käytetyt paikkatietoaineistot. Aineistot luetaan input- 
kansiosta 
 
Työkalun käyttäminen R-ohjelmassa 
 
Avataan R-studio ja smcda.R-tiedosto. Tehdään tarvittavat muutokset skriptissä olevien ohjeiden 
mukaan ja ajetaan malli. 
 
Työkalun käyttäminen Qgis-ohjelmassa 
 
Kopioidaan smcda_qgis.rsx-tiedosto QGIS:n lukemaan R-script folderiin (kts. 2.5.1 R-ohjelman linkitys 
QGIS-ohjelmaan). Avataan QGIS ja Processing Toolbox -valikosta R > raster > smcda_qgis (klikataan 
hiiren oikealla ja edit). Jos R-ikonia ei löydy luettelosta pitää se aktivoida plugins > manage and install 
plugins > installed > täppää ruksi Processing R-provider. Muutetaan skriptiin aineistojen oikeat 
tiedostopolut ja valitaan run script > run.  



 

 
 
Yleisiä ohjeita R-lisäosan käyttöön: 
https://docs.qgis.org/3.4/en/docs/training_manual/processing/r_intro.html    
 
R-syntaksit QGIS-ohjelmassa:  
https://docs.qgis.org/3.4/en/docs/training_manual/processing/r_syntax.html  
 
 

  

https://docs.qgis.org/3.4/en/docs/training_manual/processing/r_intro.html
https://docs.qgis.org/3.4/en/docs/training_manual/processing/r_syntax.html


 

3 Menetelmän vahvuudet ja 
heikkoudet 
 
 
StrateGIS-menetelmän keskeinen etu on, että se auttaa näkemään erot faktatiedossa ja 
arvopohjaisissa valinnoissa sekä muuntamaan alueen strategisia tavoitteita paikkatiedoksi. 
Suunnittelun tukena monitavoitearviointimenetelmien tapaan se on myös oppimisprosessi, jossa 
tärkeää on yhteinen ymmärrys tavoitteista ja kriteereistä (Tiitu ym. 2018).  
 
Painokertoimien vaikutus lopputulokseen on merkittävä, minkä takia on tärkeää kiinnittää huomiota 
siihen, ketkä painokertoimet määrittävät ja miten (Tiitu & Helminen 2019). Pisteytystilanteessa, 
kuten myös kriteerien valinnassa tulisi olla mukana laaja joukko eri alojen asiantuntijoita, jolloin 
tutkimusongelmaan saadaan mahdollisimman laaja näkemys eri sektoreilta. Tämä lisää myös 
menetelmän ja tulosten läpinäkyvyyttä ja hyväksyttävyyttä, jotka ovat tärkeitä tekijöitä prosessin 
oikeudenmukaisuuden kannalta (esim. Tyler 2000). Menetelmän käytettävyyden ja läpinäkyvyyden 
kannalta on myös tärkeää, että painokertoimien määritys raportoidaan ja sen vaikutus tuotettuihin 
lopputuloksiin tunnistetaan.  
  
Rakennetun ympäristön hyvinvointitekijät ovat usein vaikutuksiltaan epäsuoria ja sidoksissa tiettyyn 
alueeseen, minkä takia työssä voidaan tarkastella vain rakennetun ympäristön tarjoamaa 
hyvinvointipotentiaalia kullakin alueella. Lisäksi yksittäiset mittarit ovat sidoksissa aineistojen 
saatavuuteen ja mittakaavaan mikä vaikeuttaa kuntien välistä vertailua. On huomioitava, että 
mittareiden painotukset voivat vaihdella riippuen siitä, ketkä mittarien painokertoimia ovat kullakin 
alueella määrittämässä työpajoissa. Vertailukelpoista pohjatietoa eri alueilta voidaan kuitenkin tuottaa 
esimerkiksi esittämällä kartalla vain ne mittarit, jotka ovat alueille yhteneväiset, ilman aluekohtaisia 
painokertoimia. Indikaattorien vertailukelpoisuutta erilaisten alueiden hyvinvointipotentiaalin 
kuvaamisessa on pohdittu tarkemmin liitteessä 3. 
 
Alueellisuus on yksi menetelmän vahvuus. Paikkatietoaineistoja hyödyntämällä voidaan kuvata 
hyvinvointikriteerit ja niiden saamat pisteet kartalla, jolloin saadaan konkreettinen näkemys kriteerin 
vaikutusalueesta ja alueellista eroista. Paikkatiedon avulla on mahdollista tarkastella muita aineistoja 
suhteessa hyvinvointipotentiaalia kuvaaviin karttoihin esimerkiksi päällekkäisanalyysin avulla. 
Esimerkiksi sosioekonomisia muuttujia kuvaavia paikkatietoaineistoja (tulotaso, koulutus ym.) 
voidaan asettaa tarjontapotentiaalia kuvaavan kartan päälle ja katsoa kuinka hyvin hyvinvointitarjonta 
ja kysyntä (sosioekonomiset muuttujat) kohtaavat. Paikkatieto toimii osittain myös menetelmän 
rajoitteena. Jos kriteeriä kuvaavaa paikkatietoa ei ole saatavilla tai sitä ei voida tuottaa resurssipulan 
vuoksi, ei kriteeriä voida ottaa huomioon tarkasteluissa. Paikkatietoaineistojen hankinta ja analyysien 
tekeminen voi olla hyvinkin aikaa vievää ja vaatii paikkatietoalan tuntemusta, mikä tulee huomioida 
prosessin ja resurssien suunnittelun yhteydessä. 
 
Menetelmä on mittakaavaltaan joustava. Hyvinvointitekijöitä tarkasteltiin kunta- ja 
seutumittakaavassa, jolloin arvopuun tavoite määriteltiin niin, että siihen on mahdollisuus vaikuttaa 
kyseisen mittakaavatason suunnittelulla. Mittakaava tulee myös huomioida indikaattorien ja 
paikkatietoaineistojen valinnassa. Mitä tarkemmalla alueelle menetelmää sovelletaan, sitä tarkempia 
paikkatietoaineistoja on oltava saatavilla.  
 
Menetelmän soveltamisessa kannattaa huomioida, että siihen saattaa sisältyä paljon 
paikkatietoaineistojen kokeilevaa käsittelyä – ainakin menetelmän läpiviennin ensimmäisellä kerralla. 
Alueellisesti paras kunkin indikaattorin kuvaustapa ei ole välttämättä alusta asti selvää, jos käytettävän 
aineiston ominaisuudet eivät ole täysin tiedossa arvopuun muodostamisen aikaan. Tavoitteena tulisi 



 

kuitenkin olla, että paikkatietoanalyysien tekovaiheessa olisi jäljellä mahdollisimman vähän 
indikaattorin muodostamiseen liittyviä päätöksiä, vaan niistä olisi sovittu jo aiemmassa vaiheessa. 
Pisteytyksen kannalta on tärkeää, että kaikilla osallistujilla on sama käsitys siitä, miten indikaattoria 
todellisuudessa kuvataan paikkatietoaineiston avulla. Tämä voi olla osittain myös haasteellista, jos 
mukana on paljon ihmisiä, joilla ei ole kokemusta paikkatiedon hyödyntämisestä. 
Paikkatietoasiantuntijalla onkin tässä iso rooli yhteisen kielen ja ymmärryksen löytämiseksi. 
 
Menetelmän muunneltavuus on sekä vahvuus että heikkous. Toisaalta menetelmä mahdollistaa 
soveltamisen erilaisiin suunnitteluongelmiin ja tarkastelumittakaavoihin. Se ei kuitenkaan tuota 
vertailukelpoista tietoa eri alueista tai ajankohdista johtuen menetelmän subjektiivisesta luonteesta. 
Menetelmän jatkosoveltamisen ideana onkin oppia suuntaamaan arvopuun kriteereitä suhteessa 
tarkasteltavaan suunnittelukysymykseen ja kulloinkin asetettuihin tavoitteisiin. 
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Liite 1. R-työkalu pisteytysten yhdistämiseksi paikkatietoaineistoihin 
 
Malli tuottaa Järvenpään viherrakenteen arvoja kuvaavan kartan spatiaalista monitavoitearviointia hyödyntäen. Mallin 
toimimiselle on seuraavat oletukset. 

• Aineistot on muutettu rasterimuotoon ja ne kattavat täsmälleen saman tutkimusalueen 
• Pikseliarvot ovat muotoa [0,1] tai jatkuvia välillä [0-1] ja niillä on sama solukoko 
• Rasterit sijaitsevat kaikki samassa kansiossa 
• Rastereita vastaavat pisteet on koottu erilliseen taulukkoon (.csv), ja aineistojen nimet vastaavat täsmälleen 

kansiossa olevien rasterien nimiä 
• Tiedostopolut aineistojen lukemiseen on muutettu  

 
# Funktion kuvaus 
# Funktio 
# Skriptiin muutettava tiedostopolku 
 
# tyhjennä Environment ja muisti. Kannattaa ajaa, jos tuntuu, että R on jumissa. 
# HUOMIO! tämän jälkeen joutuu aloittamaan alusta 
rm(list = ls()) 
lapply(paste('package:',names(sessionInfo()$otherPkgs),sep=""),detach,character.only=TRUE,unload=TRUE) 
.rs.restartR() 
 
# Ladataan tarvittavat paketit  
# Tarvitsee tehdä vain kerran 
install.packages("raster") 
install.packages("rgdal") 
install.packages("sp") 
install.packages("spdep") 
install.packages("raster") 
install.packages("foreach") 
 
# otetaan paketit käyttöön  
require(raster) 
require(rgdal)  
require(sp) 
require(spdep) 
require(foreach) 
 
# luetaan esikäsitellyt rasterit kansiosta 
raster_files <- list.files("D:/HYMY/gis/demo/input/", pattern=".tif$")  
# vaihda tiedostopolku kansioon, jossa aineistot sijaitsevat 
list_raster <- lapply(raster_files, function(fl){ 
  raster(paste0("D:/HYMY/gis/demo/input/", fl)) }) 
# vaihda tiedostopolku kansioon, jossa aineistot sijaitsevat 
 
# nimetään rasterit samoin kuin kansiossa 
names(list_raster) <- (raster_files)  
 
# plotataan haluttu rasteri testiksi 
plot(list_raster[[1]]) # [[1]] vastaa kansion ensimmäistä rasteria 
 
# luetaan pistetaulukko 
# pistetaulukon tulee sisältää kolumnit [AineistoNimi], [Pisteet] 
# lisäksi taulukossa on hyvä olla lyhyt [AineistoKuvaus], mutta tämä ei ole välttämätöntä mallin kannalta 
pisteet<-read.table("D:/HYMY/gis/demo/pisteytysDEMO.csv", header = TRUE, sep =";", dec=".")  
# vaihda tiedostopolku kansioon, jossa pistetaulukko sijaitsee 
 
 
 
# pisteytetään aineistoa vastaavat rasterit 
foreach (i = 1:length(list_raster)) %do%{ 
  r1=list_raster[[i]] # valitsee listalta pisteytettävän rasterin 
  id=names(list_raster)[[i]] # muodostaa uuden [id] muuttujan rasterin nimestä 
  p1<-pisteet[pisteet$AineistoNimi == id,] # valitsee rasteria vastaavan pistemäärä taulukosta 



 

 
  # pisteyttää rasterin kertomalla jokaisen solun taulukon pistemäärällä 
  r2<-r1*(p1[,2]) 
   
  # nimeää rasterin ja tallentaan sen kansioon 
  writeRaster(r2, file.path("D:/HYMY/gis/demo/pisteytetyt/",names(list_raster)[[i]]), bylayer = F, suffix='names', 
              format="GTiff", overwrite = T) } 
# vaihda tiedostopolku kansioon, johon rasteri tallennetaan 
 
# rasterien summaaminen 
# luetaan pisteytetyt rasteripinnat kansiosta 
raster_files_uusi <- list.files("D:/HYMY/gis/demo/pisteytetyt/", pattern=".tif$")  
# vaihda tiedostopolku kansioon, jossa aineistot sijaitsevat 
list_raster_uusi <- lapply(raster_files_uusi, function(fl){raster(paste0("D:/HYMY/gis/demo/pisteytetyt/", fl)) }) 
# vaihda tiedostopolku kansioon, jossa aineistot sijaitsevat 
 
# summataan rasterit 
rasteri_summattu<-do.call("sum",list_raster_uusi) 
 
# normalisoidaan rasteri välille [0,1] jakamalla pikselin maksimiarvolla 
tulosrasteri<-rasteri_summattu/maxValue(rasteri_summattu) 
 
# plotataan lopullinen rasteripinta 
plot(rasteri_summattu)  
# Pisteytyksien perusteella muodostettu loppukartta, joka kuvastaa viherrakenteen arvoja ekosysteemipalveluiden 
näkökulmasta. Pikselin korkeampi arvo tarkoittaa viherrakenteen kannalta tärkeämpää aluetta. 
 
plot(tulosrasteri)  
# Pisteytyksien perusteella muodostettu loppukartta, joka kuvastaa viherrakenteen arvoja ekosysteemipalveluiden 
näkökulmasta. Aineisto on normalisoitu välille [0-1]. Pikselin korkeampi arvo tarkoittaa viherrakenteen kannalta tärkeämpää 
aluetta. 
 
# Tallennetaan lopulliset tulosaineistot 
# summattu rasteri 
writeRaster(rasteri_summattu,  "D:/HYMY/gis/demo/output/summarasteri.tif", bylayer = F, suffix='names', 
            format="GTiff", overwrite = T)  
# vaihda tiedostopolku kansioon, johon aineistot tallennetaan 
 
# summattu ja normalisoitu rasteri 
writeRaster(tulosrasteri,  "D:/HYMY/gis/demo/output/summarasteri_n.tif", bylayer = F, suffix='names', 
            format="GTiff", overwrite = T)  
# vaihda tiedostopolku kansioon, johon aineistot tallennetaan 
  



 

Liite 2. Lisäohjeita paikkatietoanalyyseihin 
Tähän liitteeseen on koostettu HYMY-hankkeen paikkatietoanalyysien ongelmaklinikoissa käsitellyt indikaattorit sekä mahdollisia 
ratkaisuja niihin. 
 

Asumisen monipuolisuus 
 

• Talotyyppien monipuolisuus: Eri talotyyppien (omakotitalo-, rivitalo-, kerrostalo) 
jakauma tietyn alueyksikön sisällä (ruutu / pienalue) 

• Monipuolinen hallintamuotojakauma: Vuokra-asuntojen, omistusasuntojen ja muiden 
asuntojen jakauma tietyn alueyksikön sisällä (ruutu / pienalue) 

• Huoneistotyyppien monipuolisuus: Yksiöiden, kaksioiden, kolmioiden (ja sitä isommat) 
jakauma tietyn alueyksikön sisällä (ruutu / pienalue) 

 
”Sosiaalisen sekoittamisen (social mix) toimenpiteet kohdentuvat asuntokantaan ja perustuvat 
oletukseen, että asuntotyypit ja asuntojen hallintaperusteet määrittelevät asukkaiden sosioekonomista 
rakennetta. Sekoittamalla erityyppistä asuntokantaa yksittäisellä alueella mahdollistetaan taustaltaan 
erilaisten väestöryhmien asuminen toistensa läheisyydessä. Eri väestöryhmien arjen liiallinen etääntyminen 
toisistaan on tämän ajatuksen mukaan epäedullista koko yhteiskunnan kannalta” (Saikkonen ym. 2018). 
 
Lähtötietona indikaattorissa voi olla esim. 

1. Kuntien omat pienalueittaiset tavoitteet jakaumille 
2. Tutkimustieto – ei löydy valmiita kynnysarvoja segregaatiokehityksen estämiselle, koska 

ilmiö on paikka- ja kulttuurisidonnainen 
3. Nykytilan analyysi ja suurimman luokan osuus jakaumasta 

 
SYKEn asumisen tutkijatyöpajassa kehiteltiin vaihtoehto ratkaisuiksi: 
 
SUOSITUS: Koska tavoitteena on vain erotella kunkin kriteerin näkökulmasta yksipuoliset / 
monipuoliset alueet, paras ratkaisu tähän on ottaa kunkin pienalueen / tilastoalueen jakauman 
suurimman luokan prosenttiluku alueen arvoksi analyysiin. Tämä skaalataan muiden kriteerien tavoin 
0:n ja 1:n välille. Käsittelytapa analyysissä toimii niin talotyypeille, hallintamuodoille kuin 
huoneistotyypeille, joissa kussakin on kolme luokkaa. Mitä isompi suurimman luokan osuus alueella 
on, sitä yksipuolisempi alue on kriteerin suhteen, eli arvot ovat lähempänä nollaa (0). Mitä pienempi 
suurimman luokan prosenttiosuus jakaumasta on, sitä monipuolisempi alue on, ja arvot ovat 
lähempänä yhtä (1). 
 
Huoneistotyyppien luokittelua (mitkä kolme kategoriaa verrataan monipuolisuuden arvioinnissa) voi 
muuttaa tavoitteen mukaan. Perusoletuksena on 1) yksiöt 2) kaksiot 3) kolmiot ja sitä suuremmat 
asunnot. Esimerkiksi lapsiperheiden hyvinvointiin tähtäävän tavoitteen kannalta voi olla 
mielekkäämpää niputtaa huoneluvut painottaen isompia asuntoja, esim. 1) yksiöt ja kaksiot 2) kolmiot 
3) isommat asunnot. 
 
Jatkossa vaihtoehtona asumisen monipuolisuuden tarkasteluun voi olla myös pienalueittain asetetut 
tavoitteet erityyppisten rakennusten ja asuntojen jakaumille kunnan / seudun asumisen 
suunnittelijoiden kanssa, jota vasten peilataan nykytilan jakaumia ja sen eroa tavoitejakaumasta. Tämä 
lähestymistapa vaatii yhteistyötä asumisen suunnittelun kanssa ja tarkkoja strategisia linjauksia eri 
asuinalueiden kehittämiseksi. 
 
  



 

Asumisen kohtuuhintaisuus 
 
Kohtuuhintaisuudelle ei ole olemassa virallista määritelmää. Vakiintuneet indikaattorit koskevat lähinnä 
asuntotuotantoa (ARA-tuotanto ja välimuodot kuten asumisoikeusasunnot) sekä ARA-asuntojen 
vuokrien vertailua vapaarahoitteiseen vuokra-asuntokantaan.  
 
Tilastokeskus laskee otospohjaisen tulonjakotilaston perusteella asumiskustannusten osuutta 
asuntokuntien käytettävissä olevista tuloista. Otospohjaisuuden vuoksi ne saa kuitenkin 
tarkimmillaan vain suuralueittain + pääkaupunkiseutu: http://stat.fi/til/tjt/2017/03/tjt_2017_03_2019-
03-13_tau_003_fi.html 
 
Usein raja-arvona pidetään, että asumiskustannusten ei tulisi ylittää 40 % käytettävissä olevista 
tuloista. Em. Tilastokeskuksen taulukossa on erikseen laskettu kuinka suurella osalla 40 % ylittyy. 
Tämä olisi hyvä mittari, jos alueellista tietoa saataisiin, vaikka ei kerrokaan vielä asumistasosta. 
 
Omistusasuntojen kohtuuhintaisuus 
 
Vakiintuneita mittareita siihen, kuinka suuri osuus omistusasunnoista on sellaisia, joihin väestöllä on 
varaa (koko kunnan väestön keskitulo), mutta ei tarvitse asua ahtaasti, ei ole kehitetty. Tällainen 
olisi mielekästä, mutta melko työlästä kehittää. Se vaatisi ainakin: 

• asuntojen luokittelun asuntokunnan koon mukaan (1, 2, 3+), pois lukien ahtaasti asuvat 
(Tilastokeskuksen määritelmän mukaan) 

• vertailua asuntokunnan tulojen ja kokojen välillä (kunnan keskitulot asuntokunnan koon 
mukaan, Tilastokeskus) 

• lähtökohdaksi kohtuuhintaiselle omistusasumiselle esim. asuntokunnan kahden vuoden 
bruttotuloja vastaava asunnon hintaa 

 
Asuntojen hinnat postinumeroalueittain (keskineliöhinta) 
 
”Karvalakkimallina” omistusasuntojen kohtuuhintaisuudelle voidaan käyttää postinumeroalueittaisia 
neliöhintoja. Tämä ei kuitenkaan huomioi asuntokoon vaikutusta neliöhintoihin, jos asuntokanta on 
hyvin yksipuolinen (esim. yksiöt vs. kolmiot tai isommat). 
 
Vuokra-asuntojen kohtuuhintaisuus 
 
Kohtuuhintaisen vuokra-asumisen mittarina voi hyödyntää esimerkiksi ARA-asuntojen osuutta 
kaikista vuokra-asunnoista. Se löytyy valmiina tilastona Tieto- ja analyysipalvelu Liiteristä 
(https://liiteri.ymparisto.fi/). Indikaattori kannattaa laskea johonkin kunnan osa-aluejakoon (tilasto- / 
pienalueet). 
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Vesistöjen saavutettavuus -indikaattori 
 

• Etenkin seudullisen mittakaavan analyyseissä olisi hyvä rajata pienemmät vesistöt pois, jotka 
eivät täytä mittakaavan vaatimuksia. Tässä lähtökohtana voisi olla esimerkiksi vähintään 5 ha 
kokoiset vesistöt, jotka sisällytetään analyysiin ja raja-arvoa pienemmät vesistöt poistetaan 
analyysistä. Tässäkin on hyvä tehdä alueellista tarkastelua ja käyttää paikallista 
asiantuntemusta hyödyksi ja katsoa vaikuttaako ehdotettu raja-arvo sopivalta. Tarvittaessa 
raja-arvoa voi muuttaa. 

• Kuntamittakaavassa vesistöjen kokoa on myös katsottava aluekohtaisesti esimerkiksi 
lisäämällä kartalle vesistöt ja suodattamalla pienimpiä vesistöjä pois eri kokovaatimuksilla. 

• Vesistökriteerit tulee aina käsitellä suhteessa asetettuun tavoitteeseen. Jos vesistön 
läheisyyttä ajatellaan virkistyskäytön näkökulmasta, siihen voi soveltaa esimerkiksi 
Ympäristöministeriön suositusta lähivirkistysalueen saavutettavuudelle (300 m).  

• Vesistöjen saavutettavuuden tarkasteluissa olisi mielekästä keskittyä niihin rantoihin, joihin 
kaikilla on vapaa pääsy – vapaisiin rantoihin. Vapaan rannan aineistoa ei kuitenkaan ole 
valmiiksi olemassa. Turun yliopistossa on kehitetty menetelmä, jolla on pyritty tunnistamaan 
vapaita rantoja mm. kiinteistörajoja, rakennuksia ja erilaisia buffereita käyttäen 
(https://www.turku.fi/sites/default/files/atoms/files/vapaat_rannat_raportti.pdf). 
Tämä menetelmä ei kuitenkaan sellaisenaan sovellu käytettäväksi esimerkiksi 
pääkaupunkiseudulla, vaan antaa virheellisiä tuloksia. Niinpä SYKEssä on testattu 
menetelmää vapaan rantaviivan aineiston muodostamiseksi käyttäen tarkempaa 
lähestymistapaa. Pohjana on samankaltainen lähestymistapa kuin Turun yliopiston kehittämä. 
Ongelmana on, että menetelmässä kaikkea ei voi jättää automatisoinnin varaan, vaan 
kohteita on tarkistettava käsin. Tämä lisää työmäärää huomattavasti. 
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Paikkatietojen lataaminen OpenStreetMap-palvelusta 
 

Tämä ohje voi olla tarpeen erityisesti, jos halutaan laskea esim. kävelyn ja pyöräilyn väyliin liittyviä 
indikaattoreita. 
 
OSM:n kannasta voi ladata kohteita esimerkiksi erilaisten Overpass API -palveluiden avulla. Koska 
OSM:n tietosisältö on valtava, kannattaa rajata sisältöä kyselyllä. Ohessa linkki, johon on upotettu 
valmiiksi kysely, joka irrottaa kannasta pyöräily- ja kävelyväylät, sekä polut. Wizard-työkalulla 
(yläpalkki) voi tehdä omia hakuja käyttäen avainsanoja. 
 
http://overpass-turbo.eu/s/PH7 
 

 
Kuva 1. Näkymä Overpass API -palveluun. Esimerkin hakulauseke hakee kannasta pyöräily- ja 
kävelyväylät, sekä polut rajatulta alueelta. 

 
Ladatakseen väylät overpassista, täytyy valita rajattava alue kartalta (manually select bbox) ja ajettava 
kysely komennolla ”run”. Aineiston voi ladata esim. GeoJSON-muodossa ja kääntää sitten vaikkapa 
QGISillä shapefileksi (Export).  
 
Kannattaa aina käydä lävitse haun datat kartalla ja katsoa näyttääkö tulokset järkeviltä. Esimerkissä 
haetut reitit eivät esimerkiksi sisällä kaikkia katuja, mitkä kuitenkin soveltunee kävelyyn. Jos on 
tarvista lisätä joitain muita reittejä tai poistaa niitä onnistuu se muokkaamalla hakulauseketta ja 
etenkin kohtia [”highway = ”jotain”]. Esimerkkiin on siis haettu: “highway=footway”, 
“highway=cycleway”, “highway=pedestrian”. Selitykset niihin  löytyvät: 
https://wiki.openstreetmap.org/wiki/Map_Features  
Jos haluat hakea esimerkiksi pelkät pyöräväylät niin hakulausekkeesta tulee poistaa muut kuin 
“highway=cycleway” kohta. 
 
Alla vielä esimerkin koodi, jonka voi kopioida hakukenttään, jos jotain ongelmia avata tuota linkkiä: 
/* 
This has been generated by the overpass-turbo wizard. 
The original search was: 
“highway=footway or highway=cycleway or highway=footway” 
*/ 
[out:json][timeout:25]; 
// gather results 
( 
  // query part for: “highway=footway” 
  node["highway"="footway"]({{bbox}}); 
  way["highway"="footway"]({{bbox}}); 

http://overpass-turbo.eu/s/PH7
https://wiki.openstreetmap.org/wiki/Map_Features


 

  relation["highway"="footway"]({{bbox}}); 
  // query part for: “highway=cycleway” 
  node["highway"="cycleway"]({{bbox}}); 
  way["highway"="cycleway"]({{bbox}}); 
  relation["highway"="cycleway"]({{bbox}}); 
  // query part for: “highway=pedestrian” 
  node["highway"="pedestrian"]({{bbox}}); 
  way["highway"="pedestrian"]({{bbox}}); 
  relation["highway"="pedestrian"]({{bbox}}); 
   // query part for: “highway=path” 
  node["highway"="path"]({{bbox}}); 
  way["highway"="path"]({{bbox}}); 
  relation["highway"="path"]({{bbox}}); 
); 
// print results 
out body; 
>; 
out skel qt;out body; 
>; 
out skel qt; 
 
Lisätietoa palvelusta ja sen käytöstä: https://wiki.openstreetmap.org/wiki/Overpass_API  
https://help.openstreetmap.org/tags/overpass/  
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Liikenteen melualueet 
 
Liikenteen melualueiden mallintamiseen voidaan käyttää ympäristömeludirektiivin mukaisia 
melualueita vuodelta 2017. Aineisto on saatavissa SYKEn ladattavista paikkatietoaineistoista:  
https://www.syke.fi/fi-FI/Avoin_tieto/Paikkatietoaineistot/Ladattavat_paikkatietoaineistot  
Huomioitavaa on, että direktiivinmukaiset melualueet kattavat vain isoimmat kaupungit. 
 
Jos aineistoa ei ole saatavilla omalta alueelta voidaan tuottaa teoreettinen melualuetarkastelu 
maanteiltä tieverkkoon perustuen. Tähän voidaan käyttää Pohjoismaisen tieliikennemelun 
laskentamallin mukaisesti puskurivyöhykemenetelmää siten, että melualueen laajuus lasketaan 
kullekin tiesegmentille liikennemäärän (ja erikseen raskaan liikenteen osuuden) sekä 
nopeusrajoitusten perusteella ((linkki tieliikennemelujulkaisuun). Työkalu on saatu Jussi 
Sääskilahdelta (Pohjois-Pohjanmaan ELY-keskus) ja sitä on kuvattu seuraavissa kappaleissa. Laskenta 
on tehty pohjoismaisen tieliikennemelun laskentamallin mukaisesti. Laskenta etenee niin, että 
lähtömelutasoon (10 metriä tien keskiviivasta) tehdään kyseisen tieosuuden liikennettä vastaavat 
korjaukset. Laskennassa on haettu 45, 55 ja 65 desibelin ekvivalenttisten päivämelualueiden (LAeq) 
leveys.   
 
Lähtömelutason laskemisessa on käytetty seuraavia tietoja: 

 kokonaisliikennemäärä 
 raskaan liikenteen osuus 
 nopeusrajoitus tai tieto keskimääräisestä ajonopeudesta. 

 
Lähtömelutaso ja siitä johtuva melualueen leveys on laskettu päivämelutasona, jolloin kello 7.00-
22.00 aikaisen liikenteen oletetaan olevan kaikilla teillä 90 prosenttia. 
 
Melun leviämistä laskettaessa käytetään teoreettista ympäristöä, jonka oletetaan olevan 
seuraavanlainen: 
 tie on suora ja äärettömän pitkä 
 tiepenkereen oletuskorkeus on yksi metri 
 maasto on avoin ja tasainen 
 maaston pinta on pehmeä 
 laskentapisteen korkeus on kaksi metriä. 
 
Melun leviämistä laskettaessa otetaan huomioon etäisyyden ja maaston melua vaimentama vaikutus. 
Maasto vaikuttaa melun vaimenemiseen, kun etäisyys on suurempi kuin kolmekymmentä metriä. 
Kaksiajorataisilla teillä melulähde sijaitsee molempien ajoratojen keskellä, mikä aiheuttaa hieman 
teoreettista leveämmän melualueen. Mallia ei ole tarkoitettu julkisivumelun laskentaan. Laskennassa 
ei voida huomioida mahdollisesti melun heijastumista laskentakohteen takana olevista kovista 
pinnoista, esimerkiksi rakennusten seinistä. 
 
Laskettu melualue on teoreettinen ja vastaa todellisuutta vain, silloin kun laskennan oletukset 
vastaavat maasto-olosuhteita. Melualue on kapeampi kuin laskettu teoreettinen melualue, paikassa, 
jossa 

 tienpinta on alle yhden metrin korkeudella ympäröivästä maastosta 
 tie on leikkauksessa tai 
 maaston muoto tai rakennukset rajoittavat melun leviämistä. 

Melualue on laajempi kuin laskettu teoreettinen melualue, paikassa, jossa 
 tienpinta on yli metrin korkeammalla ympäröivää maastoa 
 tie on vesistön kohdalla tai muun laajan, hyvin ääntä heijastavan alueen kohdalla tai 
 tie on hyvin melua heijastavan pitkän seinämäisen esteen kohdalla. 

 
© 14.2.2020 Jussi Sääskilahti, Pohjois-Pohjanmaan ELY-keskus, käyttö omalla vastuulla. 
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Etäisyyden laskenta tieverkkoa pitkin 
 
Palveluiden osalta saavutettavuus etäisyytenä tieverkkoa pitkin on hyvä vaihtoehto linnuntie-
etäisyydelle. Tällöin siinä päästään lähemmäksi totuutta saavutettavuuden osalta, koska iso osa 
palveluista saavutetaan juurikin teitä pitkin. Tämä vaatii hiukan enemmän paikkatietoanalyysejä, kuin 
linnuntie-etäisyys, mutta todennäköisesti takaa myös tarkemmat tulokset. 
 
Etäisyysvyöhyke (Service Area eli ns. palvelualue) kannattaa muodostaa käyttämällä Network-
analyst-työkalua, joka löytyy ainakin Qgis ja ArcMap -ohjelmistoista.  
Qgis: https://docs.qgis.org/3.4/en/docs/training_manual/vector_analysis/network_analysis.html  
Qgis: https://planet.qgis.org/planet/tag/routing/ (kts. esim. kohta QNEAT3 plugin) 
ArcMap: https://desktop.arcgis.com/en/arcmap/latest/extensions/network-analyst/service-area.htm 
 
Ideana on, että asetetaan lähtöpisteeksi esimerkiksi päiväkodit ja lasketaan niistä palvelualueet 
tieverkkoa pitkin halutulle etäisyydelle. Työkalussa on monia eri mahdollisuuksia, jotka selviävät 
linkkien takaa, mutta esimerkiksi QNEAT3 plugin mahdollistaa polygonin muodostamisen 
palvelualueesta (työkalu: iso area as polygon from point). Kyseinen plugin pitää ensin ladata Qgis-
ohjelmaan (kts. kappale 2.5.1). Tieverkkoaineistona voi käyttää esimerkiksi DIGIROAD-tieverkkoa 
tai OpenStreetMapin tieverkkoa. 
  

https://docs.qgis.org/3.4/en/docs/training_manual/vector_analysis/network_analysis.html
https://planet.qgis.org/planet/tag/routing/
https://desktop.arcgis.com/en/arcmap/latest/extensions/network-analyst/service-area.htm


 

Aineistojen muuntaminen etäisyysrasteriksi 
 
Esimerkissä muodostetaan lähikaupoille jatkuva rasteripinta 500 m kynnysarvoon asti Qgis 
ohjelmalla.  Lähikauppoja lähinnä olevat pikselit saavat arvokseen 1, josta pikselien arvo vähenee 
lineaarisesti etäisyyden kasvaessa kynnysarvoon asti ja saavuttaa arvon 0. Kynnysarvon ulkopuliset 
alueet saavat myös arvon 0. 
 
Lähtöaineisto 

• Lähikaupat (pisteaineisto) 
• Lahden kuntaraja (polygon) 

 
Työvaiheet 
 

1. Varmistetaan, että paikkatietoaineistot ovat yhteneväisessä koordinaatistossa (esim. ETRS-
TM35FIN).  

 

 
 

2. Lisätään kenttä [id] pt-kauppa pisteille 
• Paina kynän kuvaa vasemmassa ylälaidassa (toggle editing mode) 
• Paina new field ja lisää kentälle nimi [id] 

 
 



 

 
 
3. Asetetaan juokseva numerointi [id] kentälle 

• Lisää yläriville koodi: @row_number 
 

 

 
 

4. Tallenna muutokset painamalla toggle editing mode nappia  
 



 

 
 

5. Muutetaan kauppapisteet rasteriksi (20 m resoluutio on soveltuva kuntakohtaiseen 
tarkasteluun). Täytä työkalun kohdat alla olevan kuvan mukaan. 

• Työkalu: Raster > Conversion > Rasterize 
i. Output extentiksi tulee valita Lahden kuntarajat 

 
 



 

 
 

6. a) Luodaan muodostetusta rasterista etäisyyspinta 
• Työkalu: Raster > Analysis > Proximity 

 



 

 
 

b) Etäisyyspinnan tulosaineisto. Lähellä koulua olevat pikselit saavat arvon 0 ja arvo nousee 
etäisyyden kasvaessa aina 500 asti. 

 
 

 
 

7. Skaalataan pikselien arvot välille [0-1] 
• Työkalu: Raster calculator: Jaetaan rasteri maksimiarvolla 500  

 
 



 

 
 

8. Käännetään pikselien arvot vastakkaisiksi, jolloin lähellä pt-kauppoja pikselin arvo on 1 
(valkoiset pikselit) ja kynnysarvon jälkeen 0 (mustat pikselit). 

• Työkalu Raster calculator: kopioi funktio kenttään: 1 - (("etäisyyspinta_0_1@1" - 0) / 
(1 - 0)) * (1- 0) + 0 

• HUOM! etäisyyspinta_0_1@1 = työstettävän rasterin nimi 
 
 
 
  



 

Tuloskarttojen visualisointi 
 
Hankkeessa tuotettu R/Qgis -työkalu tuottaa kriteerien pisteytyksiin perustuvan kartan, jossa on 
mukana kaikki arvopuun kriteerit. Tämä toimii esimerkkinä menetelmän yhdestä tuloksesta 
visuaalisessa muodossa, eli se osoittaa kokonaistavoitteen vaihtelun tutkimusalueella. 
Huomionarvoista on, että tämä on vain yksi tapa tarkastella tuloksia, joten on suotavaa tarkastella 
karttoja erikseen esimerkiksi teemoittain karttasarjoina, eikä pelkästään lopullista ns. synteesikarttaa. 
Teemakohtaisella tarkastelulla päästään tarkemmin kiinni siihen, mitkä kriteerit vaikuttavat alueen 
hyvinvointipotentiaaliin. Yksittäisten teemojen tarkastelu onnistuu myös olemassa olevalla työkalulla, 
kun muuttaa pisteytys-Exceliä ja työkaluun luettavia rastereita sen mukaan, mitä haluaa tarkastella. 
 
Lopulliset visualisoinnit tai jatkotyökalut on kuntien muodostettava itse. Kuvassa 1 olevassa 
Jyväskylän esimerkissä on kuvattu 3 eri teeman 1) palveluiden, 2) viherympäristön ja 3) 
lähiympäristön tarjoama hyvinvointikokonaisuus viisiportaisella luokituksella, jossa on tasaiset 
luokkavälit. Punaiset alueet kuvaavat korkeaa tarjontapotentiaalia ja keltaiset matalampaa. Kartasta 
saa suoraan hyvän kuvan alueellisesta hyvinvointipotentiaalin vaihtelusta, ja sitä voi vielä testata 
erilaisilla luokkamäärillä ja -rajoilla. Toinen visualisointiesimerkki (kuva 2) kuvaa Järvenpään 
viherrakenteen arvoja, jossa arvopuun tuloksia on esitetty kvantiileihin pohjautuvalla viisiportaisella 
luokituksella, missä luokka-arvot on korvattu korkea – matala-asteikolla. 
 
 

 
Kuva 1. Esimerkkivisualisointi Jyväskylästä (© Anni Mäkelä, Jyväskylän kaupunki). 



 

 
Kuva 2. Esimerkkivisualisointi Järvenpään viherrakenteesta (Tiitu ym. 2016). 
 
Visualisoinnissa huomioitavia asioita 
 

• Visualisoinnin valinnat liittyvät hyvän kartografian perusominaisuuksiin 
• Luokkien määrä:  

- Mitä enemmän luokkia ottaa kartalle mukaan, sitä tarkemmalla tasolla tulokset 
näkyvät. Luokkien määrän nostaminen vaikuttaa kuitenkin aina kartan luettavuuteen.  

- Erilaisia luokitteluja kannattaa ehdottomasti kokeilla, jotta saadaan vaihtelua eri 
alueiden välillä optimaalisesti näkyviin. 

• Kartan sisältävän informaation määrä:  
- Esitetäänkö yksittäisiä teemoja karttasarjoina vai kaikki teemat yhdellä kuvalla? Jos 

esitetään yksittäisiä teemoja esimerkiksi karttasarjoina, kannattaa värit, taustakartat 
ja muu kartan informaatio pitää muuttumattomana. Tällöin kartan lukijan on 
helpompi seurata alueellisia vaihteluja.  

- Kartoista voi tehdä myös animaatioita (gif) 
• Värimaailma: 

- Kannattaa pyrkiä huomioimaan mm. puna-viher-värisokeus ja välttämään ko. sävyjen 
esittämistä rinnakkain 

- Katse hakeutuu lämpimiin värisävyihin, sillä ne näyttävät sijaitsevan lähempänä kuin 
kylmät. Siksi lämpimiä kannattaa suosia. 

• Kartan mittakaava:  
- Koko kuntaa kuvaava kartta on yleispiirteisempi kuin jollekin kunnan osa-alueelle 

kohdistettu kartta. 
- Hyvän kartan perusominaisuuksia ovat lisäksi selkeä legenda, pohjoisnuoli ja 

mittakaavajana 
 

  



 

Ilmanlaatu 
 
Ilmanlaadun arviointiin voidaan hyödyntää Suomen ympäristökeskuksen tuottamia 
pienhiukkaspitoisuustietoja. Pitoisuudet perustuvat kahteen malliin: Suomen päästöjen aiheuttamat 
pitoisuudet on mallinnettu SYKEn FRES-mallilla, ja kaukokulkeumapitoisuudet IIASA-instituutin 
GAINS-mallilla. Tulokset kuvaavat pienhiukkasten vuosikeskiarvopitoisuuksia vuonna 2015. 
Ilmanlaatuun vaikuttavat myös muut ilmansaasteet, mutta pienhiukkaset ovat merkittävin 
terveysvaikutusten aiheuttaja, ja tulokset sopivat alueiden väliseen ilmanlaadun erojen vertailuun.  
 
Kunnat voivat kysellä SYKEn päästöihin ja pienhiukkasten pitoisuuksiin liittyviä aineistoja jatkossa 
esimerkiksi Niko Karvosenojalta (niko.karvosenoja@ymparisto.fi) tai Ville-Veikko Paunulta (ville-
veikko.paunu@ymparisto.fi).  
 
Lisätietoa ilmansaastemallinnuksista:  

• Energia- ja ilmastostrategian ja keskipitkän aikavälin ilmastopolitiikan suunnitelman 
ympäristövaikutusten arviointi: 
https://julkaisut.valtioneuvosto.fi/handle/10024/80289 

 
• FRES-päästömalli:  

https://www.syke.fi/hankkeet/fres 
https://syke.fi/emissionmap   

 
• GAINS-malli: 

https://iiasa.ac.at/web/home/research/researchPrograms/air/GAINS.html 
 

• IHKU-malli terveyshaittojen laskemiseen kunnittain: 
https://www.syke.fi/hankkeet/ihku/ihkumalli  

 
•  KILTOVA-hanke: https://www.syke.fi/fi-

FI/Ajankohtaista/Kaupunkien_ilmastotoimien_vaikutukset_mo(53050)   
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PPGIS-aineistojen käsittely 
 
Aineiston tietosisältö ja formaatti (piste, viiva, polygoni) määrittävät pitkälti aineistojen 
hyödyntämisen tapoja. Tietoa voi jalostaa käytettävään muotoon esimerkiksi erilaisilla klusteri- ja 
hotspot-analyyseillä. Lisäksi pistemäistä aineistoa voi yhdistää aluemuotoisiin toiminnallisiin 
aluejakoihin, kuten esimerkiksi viherrakennetta kuvaaviin polygoneihin tai asuinalueisiin, mikä yleistää 
tietoa kuntamittakaavaan sopivalle tarkkuustasolle. PPGIS-aineistojen alueellinen jakauma ei 
useinkaan ole edustava, sillä tietoa kerätään usein avoimena nettikyselynä eikä tilastolliseen otantaan 
perustuvana postikyselynä. Se vääristää vastaajien jakaumaa, mutta on tehokkaampi tapa saada 
vastaajia kuin postikysely, joka on myös usein kalliimpi vaihtoehto tiedon tuotantoon. Siitä huolimatta 
PPGIS-kyselyiden tuottama tieto on arvokasta, kunhan sen keräämistapaan liittyvät rajoitteet otetaan 
huomioon aineiston analyysissä ja tulkinnassa. 
  



 

Liite 3. Kuntien välisten vertailuindikaattoreiden pohdinta HYMY-hankkeessa 
 
Rakennetun ympäristön hyvinvointi-indikaattorit kuntien välisessä vertailussa 
Kuntien yhteisiä hyvinvointi-indikaattoreita pohdittiin 13.11.2019 kaikkien HYMY-hankkeen kuntien yhteisessä 
työpajassa Tampereella.  
 
 

Yhteiskeskustelu mahdollisista indikaattoreista 
 
- Työpajassa nousi esille yhteisten hyvinvointi-indikaattorien laadinnan tavoitteet ja käyttötarkoitus. Minkä takia 

yhteisiä hyvinvointi-indikaattoreita laaditaan? Onko mielekästä vertailla rakennetun ympäristön 
hyvinvointipotentiaalia eri kuntien kesken? Mitä vertailutuloksella halutaan saavuttaa? 

- Rakennus- ja asuntokannan monipuolisuusindikaattori ei välttämättä ole mielekäs.  
- Esimerkiksi monipuolista talotyyppijakaumaa ei välttämättä haluta kaupungin keskustaan – eikä 

siksi välttämättä ole soveltuva indikaattori  
o Asuntotyyppien monipuolisuus on ehkä relevantimpi (pienet / isot asunnot)  
o Lähiöissä talotyyppien monipuolisuudella ja sen jakaumalla on enemmän merkitystä 

(kerrostalot/pientalot) 
 

- Indikaattoreita voisi pohtia sen kautta, mistä päättäjät haluavat usein tietoa esimerkiksi palveluverkkosuunnittelun 
tueksi: 

o Palveluiden saavutettavuus  
- Päivittäispalvelut: koulut, päiväkodit, lähikaupat 
- Harvemmin tarvittavat palvelut: sosiaali- ja terveyspalvelut 
- Hyvien kulkuyhteyksien huomiointi 

o Luonto- ja virkistys  
- Viher- ja virkistysalueiden saavutettavuus  
- Näkökulmina liikunta ja liikkuminen, virkistäytyminen 

o Turvallisuus ja asuinalueiden koheesio  
- (esim. liikenneturvallisuus, rikollisuus, katujen kunnossapito, turvallisuuskyselyt – 

on valtakunnallinen) 
 

- Vesistön läheisyys ja arvokkaat maisema-arvot eivät relevanttia vertailutietoa: vesistöjä ei tule lisää, eikä rantojen 
rakentamista tulisi suosia. Arvokkaat maisema-alueet eivät juuri muutu, eikä niihin pysty vaikuttamaan suoraan. 
 

- Melu: isommissa kaupungeissa on tehty meluselvityksiä – tieto täytyy olla vertailukelpoista. Esimerkiksi Syken 
koostamaa vuoden 2017 EU:n ympäristömeludirektiivin mukaista meluselvitystä ei löydy kaikista HYMY-kunnista ja 
tällöin sitä ei voi hyödyntää. 

 
- Liikuntapaikat on laaja kokonaisuus, LIPAS-tietokanta on valtakunnallisesti käytössä ja se sisältää paljon erilaisia 

palveluita. Mikä on lähipalvelua ja mikä ei? Ei tarvita esim. jäähallia joka lähiöön. 
 

- Kohtaamisia luovat ja yhteisöllisyyttä tukevat palvelut: kirjastot, asukastilat, nuorisotilat, kirjastoautojen pysäkit 
(mahdollisesti myös mukaan) yhteisöllisyyden indikaattorina 

 
- Työpaikkojen saavutettavuus: mistä työntekijät tulevat – kuinka saavutettavia työpaikat ovat? Työmatkojen 

keskipituuden (linnuntienä) pystyy esimerkiksi laskemaan YKR-tiedoista, mutta onko vertailutieto käyttökelpoinen 
tai relevantti? Kulkutapa vaikuttaa olennaisesti matka-aikaan. 

 
- Saavutettavuuden laskenta täytyy pohtia. Vaihtoehtoina:  

 
 Linnuntie-etäisyysvyöhyke – soveltuu erityisesti lyhyille etäisyyksille 
 Matkan pituuteen perustuva saavutettavuus tieverkkoa pitkin (esimerkiksi Digiroad-aineiston pohjalta on 

tuotettavissa saavutettavuuspinta, joka ei huomioi kulkumuotoa). 
 Matka-aikaa perustuva saavutettavuus tieverkkoa pitkin (esimerkiksi Digiroad-aineiston pohjalta on 

tuotettavissa saavutettavuuspinta, joka huomioi kulkumuodon (kävely, pyöräily ja auto). Joukkoliikenteen 
huomioiminen on hankalampaa saavutettavuuslaskennassa, sillä se vaatii mm. reititysten tekemistä.  

- Lähivirkistysalueet voidaan määritellä eri tavoin. Esimerkiksi seudullisen kestävän kehityksen mittareihin (Seutu-
KEKE) perustuva lähivirkistysalueen määrittely pohjautuu tiettyihin Corine-maanpeiteaineiston luokkiin ja alueen 
vähimmäiskokoon. 

 Virkistysalueen laadun huomioiminen on haastavaa, jos halutaan tuottaa vertailukelpoista tietoa. 
Kaupunkien omat viherverkostoaineistot eivät välttämättä ole vertailukelpoisia. 

 



 

Ehdotuksia kuntien vertailuindikaattoreiksi 
 
Palveluiden saavutettavuus 
 

o Oppilaitosten saavutettavuus 
o Lähikaupan saavutettavuus 
o Päiväkotien saavutettavuus 
o Joukkoliikenteen palvelutaso  

- SYKEn kaksitasoinen joukkoliikennevyöhykkeet -aineisto, joka kuvaa 
joukkoliikenteen tarjontaa. Intensiivinen joukkoliikennevyöhyke kuvaa aluetta, jossa 
on tiheä vuoroväli ja lyhyt kävelyetäisyys pysäkille. Joukkoliikennevyöhyke kuvaa 
tätä heikomman palvelutason aluetta, joissa joukkoliikenne kuitenkin palvelee 
riittävällä tasolla ruuhka-aikana.  

• Voidaan myös esim. verrata, kuinka suuri osa palveluista on 
vyöhykkeiden mukaan saavutettavissa, eli yhdistää joukkoliikennettä 
palveluiden saavutettavuuteen 

 
Luonto- ja virkistys 
 

o Lähivirkistysalueiden saavutettavuus 
- Seutu-KEKE mittareihin perustuvaa virkistysalueiden saavutettavuustietoa on 

saatavilla avoimena tilastona elinympäristön tieto- ja analyysipalvelu Liiteristä 
(https://liiteri.ymparisto.fi/) 

  
Turvallisuus ja asuinalueiden koheesio 

o Yhteisöllisyyttä tukevien palveluiden saavutettavuus 
o Turvallisuus, miten voitaisiin kuvata: 

- Katuturvallisuusindeksi? Selvitettävä tiedon käyttökelpoisuus eri kunnissa 
- Pelastusviranomaisten aineistot (onnettomuudet)?  
- Poliisin tietoon tulleet rikokset jne. ja siitä koostettu indikaattori  
- Tilastokeskuksen tieliikenneonnettomuudet valtakunnallinen aineisto 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://liiteri.ymparisto.fi/
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